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Ordering Crossword Compiler in N. America
See also ordering in the UK, Australia and elsewhere

The full version can create, save and export puzzles up to 50x50 squares and all the features are 
enabled. Order it now!

Order Online

You can pay by credit card and download the full program immediately. 

Follow the links from http://www.x-word.com/ordering.html. 

The following are available:

Crossword Compiler $45

Additional word lists (see below) $25

WordWeb Pro thesaurus/dictionary $25

Language word lists $12.50

UK word lists $12.50

Crossword Compiler Bundle (all of the above) $89

Professional Grid Filler $99

Crossword Compiler Pro Bundle

(includes all of the above)

$159

All prices are in US dollars.

Phone, FAX and mail orders

The following combinations are available from ShareIt! Inc.

(#106786) Crossword Compiler $45

(#106787) Crossword Compiler Bundle $89

(#106789) Crossword Compiler Professional $144

(#106790) Crossword Compiler Professional Bundle $159

The Bundle options include WordWeb Pro thesaurus/dictionary and all the optional word lists. The 
Professional options include the Professional Grid Filler.

Please add $15 if you would like a CD-ROM sent by mail, otherwise download instructions will be sent to 
your e-mail address.

You can order from ShareIt! Inc. by credit card, check or purchase order in the following ways:

Phone:    1-800-903-4152 or (724) 850-8186 

FAX or Mail:    Print out, fill in and send this order form



Please quote the product number given above when you order.

THESE DETAILS ARE FOR ORDERS ONLY. 

Please e-mail any questions to ordering@x-word.com. Up to date information about the program can also
be found on the Internet at http://www.x-word.com.

Optional word lists

Additional word lists.
Compound words and phrases. Words and expressions from Webster's second edition. Medical, legal, 
and ethnic words. Movies and literature. Lists of names, cities and US places. Large list of unusual words 
and variant spellings. 

Language word lists
Danish, Dutch, Finnish, French, German, Icelandic, Italian, Russian, Latin, Norwegian, Spanish, Swedish

UK word lists
UK Advanced Cryptics Dictionary (large list of 200,000+ words and compounds), UK place names, 
Scottish and RAF words.



Ordering Crossword Compiler in the UK
See also ordering in N. America, Australia and elsewhere

Crossword Compiler is British software and in the UK can be purchased directly from the author. The 
prices are as follows:

Crossword Compiler 5 £28 

WordWeb Pro thesaurus/dictionary £15 

Additional word lists (see below) £12 

UK word lists £6 

Language word lists £6 

Crossword Compiler Bundle (all of the above) £55 

Professional Grid Filler £59 

Professional Bundle (all of the above) £89 

ORDERING BY CHEQUE, Postal Order or Purchase Order.

Cheques should be payable to Antony Lewis and mailed to

Antony Lewis, 16 Townley Rd, London SE22 8SR, UK.

Click here to print out an order form that you can fill in and send.

ORDERING BY CREDIT CARD OVER THE INTERNET

You can order the program (for $45 US) and download it immediately by following the link from 
http://www.netword.demon.co.uk/ordering.html.

The Optional word lists

Additional word lists.
Compound words and phrases. Words and expressions from Webster's second edition. Medical, legal, 
and ethnic words. Movies and literature. Lists of names, cities and US places. Large list of unusual words 
and variant spellings. 

Language word lists
Danish, Dutch, Finnish, French, German, Icelandic, Italian, Russian, Latin, Norwegian, Spanish, Swedish

UK word lists



UK Advanced Cryptics Dictionary (large list of 200,000+ words and compounds), UK place names, 
Scottish and RAF words.



WordWeb Pro
Ordering in the UK, N. America,, Australia and elsewhere

WordWeb is a comprehensive thesaurus/dictionary that can be used directly from Crossword Compiler or 
run as a separate program. It's also a handy tool for solving puzzles.

Powerful thesaurus/dictionary

· Definitions and synonyms
· Over 100,000 synonym sets, 120,000 root words and 160,000 word forms 
· Related words: antonyms, words for parts and types, etc.
· Includes many proper nouns
· Filter synonyms by sense and part of speech

Pattern matching word find

· Fast search through huge 160,000 word list
· Use vowel/consonant and letter group placeholders
· Punctuation sensitive searches

Anagram finding

· Find straight and multi-word anagrams
· Anagram word order changed to make multi-word anagrams more grammatical
· Find partial anagrams: e.g. How many words can you make using the letters in …?

Edit and add to the database

· Edit individual definitions and synonym sets
· Add new words and definitions

Use WordWeb from Crossword Compiler

· Use the word list containing 160,000 words for grid filling/word finding 
· Lookup words in the grid or in the clue editor
· Automatically paste synonyms from WordWeb into the clue editor
· Automatically format compound words that are in WordWeb

MS Word macro to display WordWeb from MS Word

Up-to-date information about WordWeb is available on the Internet at http://www.wordweb.co.uk/.

If you have any questions or would like more information please E-Mail info@wordweb.co.uk.



Ordering in Australia and New Zealand
See also ordering in the UK, N. America, and elsewhere

Crossword Compiler is available in Australia/New Zealand from our local distributor Shareware-Australia. 
You may also wish to order online in US dollars – follow the links from 
http://www.x-word.com/ordering.html for details.

The following are available (prices in Australian dollars):

Crossword Compiler $79

Crossword Compiler Bundle

(includes lots of extra word lists and WordWeb Pro )

$149

Professional Grid Filler

(optional add-on for either of the above)

$159

You can order by phone, fax, email, postal mail or online.

Fax your order to (02) 9565-2362
Phone your order to (02) 9565-2339
Email your order to sales@shareware-australia.com
Mail your order to: Shareware-Australia, PO Box 1075, Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, Visacard, or American Express.

There is an order form that you can print out and send.

The extra word lists

Additional word lists.
Compound words and phrases. Words and expressions from Webster's second edition. Medical, legal, 
and ethnic words. Movies and literature. Lists of names, cities and US places. Large list of unusual words 
and variant spellings. 

Language word lists
Danish, Dutch, Finnish, French, German, Icelandic, Italian, Russian, Latin, Norwegian, Spanish, Swedish

UK word lists
UK Advanced Cryptics Dictionary (large list of 200,000+ words and compounds), UK place names, 
Scottish and RAF words.



Crossword Compiler 5 Order Form

Select Print Topic... from the File menu and fill in the form to order by post. 
Alternatively see the other ways of ordering

Name:

Company name:

Address:

Your email address:
(This MUST be given unless you 
pay the P&P for shipping a CD-ROM)

Where did you hear about Crossword Compiler?

Item Price Quantity Subtotal
Crossword Compiler £28 _______ _______
WordWeb Pro thesaurus/dictionary £15 _______ _______
Additional word lists £12 _______ _______
UK word lists £6 _______ _______

Language word lists £6 _______ _______
Crossword Compiler Bundle 
(all of the above) £55 _______ _______

Professional Grid Filler £59 _______ _______

Professional Bundle (all of the above) £89 _______ _______

Postage and Packing:
(If you want a CD-ROM by mail)

£5 _______

Total: _______

Please make cheques payable to Antony Lewis and mail to:

Antony Lewis, 16 Townley Rd, London SE22 8SR, UK.



Ordering Elswhere
See also ordering in the UK, N. America, and Australia

Credit card orders

This is probably the easiest option. Follow the instructions under Ordering in N. America. You can also 
order by a FAX to a local number in many countries – please see http://www.x-word.com/ordering.html for 
details.

Credit card and cheque orders in Euros

You can order online in Euros, see http://www.x-word.com/ordering.html details. 

The following are available from ShareIt, with prices in Euros:

(#106786) Crossword Compiler 45

(#106787) Crossword Compiler Bundle 89

(#106789) Crossword Compiler Professional 144

(#106790) Crossword Compiler Professional Bundle 159

The Bundle options include all the extra word lists (see below) and WordWeb Pro, the Professional 
options include the Professional Grid Filler.

Add 15 Euros P&P if you would like a CD-ROM by mail, otherwise download instructions will be sent to 
your e-mail address.

Please quote the product number above when you order. Mail to

ShareIt!
element 5 AG
Sachsenring 69
50677 Koeln
Germany

or

Phone: +49-221-2407279 
Fax:    +49-221-2407278
E-Mail:    register@shareit.com

Other orders

CHEQUES and EUROCHEQUES

You can pay by Eurocheque or get your bank to make out a Sterling cheque. Alternatively I can accept 
cheques made out in any convertible currency. Please calculate the total amount payable in pounds, add 
£5 (to cover the bank charge for accepting foreign cheques), and work out how much that is in your local 
currency. See Ordering in the UK for pricing or click here to print out an order form that you can fill in and 
send.

OTHER METHODS OF PAYMENT



You can also pay by electronic transfer and possibly by non-Sterling cash. Please e-mail compiler@x-
word.com for details. 

The extra word lists

Additional word lists.
Compound words and phrases. Words and expressions from Webster's second edition. Medical, legal, 
and ethnic words. Movies and literature. Lists of names, cities and US places. Large list of unusual words 
and variant spellings. 

Language word lists
Danish, Dutch, Finnish, French, German, Icelandic, Italian, Russian, Latin, Norwegian, Spanish, Swedish

UK word lists
UK Advanced Cryptics Dictionary (large list of 200,000+ words and compounds), UK place names, 
Scottish and RAF words.



Ordering Crossword Compiler

This demo version of Crossword Compiler can only save and export small puzzles up to 10x10 squares 
and some features are disabled. The full version can save and export puzzles up to 50x50 squares and 
has all the features enabled. Order it now!

Please select an ordering location:

Ordering in N. America

Ordering in the UK

Ordering in Australia and New Zealand

Ordering elsewhere

You can also order online at http://www.x-word.com/ordering.html

Online ordering is by credit card, debited in US dollars. You can either download the program immediately
or get a CD-ROM by mail.

Various optional extras are available, including WordWeb Pro, a thesaurus/dictionary, and the 
Professional Grid Filler.



Crossword Compiler Order Form

Select Print Topic from the file menu, fill in the form and mail your 
order to: 

Shareware-Australia, PO Box 1075, Maroubra NSW 2035, Australia

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, 
Visacard, or American Express.

Name:___________________________________________________________________

Address: _______________________________________________________________

         _______________________________________________________________

Phone: ____________Fax: ____________ Email: ____________________________

Paid by Cheque/Money Order [ ]  Credit Card [ ]

Credit Card No. _________________________________________________________

Expiry Date: __________  Signature: _____________________________________

Please supply

__ copies of Crossword Compiler @ AU$ 79.00 each $______

__ copies of Crossword Compiler Bundle  @ AU$ 149.00 each $______
__ copies of Professional Grid Filler @ AU$ 159.00 each $______

Postage & Handling @ AU$ 20
(Not applicable for delivery by e-mail) $______

Total $______

Deliver by Post [ ]   e-mail [  ]



Crossword Compiler Order Form

Select Print Topic from the file menu to print out the form.

Your name:

Company name:

Address:

FAX: Phone:

Your email address:
(This MUST be given unless you pay 
the S&H for shipping a CD-ROM)

Product Name Price Number Subtotal

106786 Crossword Compiler $45 ______ ______

106787 Crossword Compiler Bundle $89 ______ ______

106789 Crossword Compiler Professional $144 ______ ______

106790 Crossword Compiler Professional Bundle $159 ______ ______
Shipping and Handling
(Not applicable for e-mail delivery) $15 ______

Total: ______

How would like to receive the full version?    e-mail: [    ]    postal mail: [    ]

How would you like to pay?    credit card: [    ]    check: [    ]    purchase order: [    ]

Credit card information (if applicable)

Credit card: Visa: [    ]    Eurocard/Mastercard: [    ]    American Express: [    ]    Diners Club: [    ]

Card holder: ________________________________

Card No.: ___________________________________ Expiration Date: ________

Date / Signature: ___________________________

Please FAX to ShareIt! Inc at (724) 850-8187 or mail to

ShareIt! Inc, PO Box 844, Greensburg, PA 15601-0844, USA
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Creating new word lists

To create a new word list, open the Word List Manager and click on the New... button. Enter a name for 
your new word list and press Create. Your new word list will now appear in the Available Word Lists box,
and it will be empty. You can type in a description of the list below the list of word lists, and press the 
Change Info button to store it permanently.

When you've made the new list you can add words to it directly, or add words from another word list.



Adding and removing words from word lists

To add or remove words from any of the existing word lists, first open the Word List Manager and select 
the list that you want to change. 

Adding words

Either press the Add... button or select Add Words form the Word List menu. After you've typed in a 
word press Enter, and it will appear in the box below with the score specified in the Score number box. 
Keep typing in words, pressing enter after each one, until you've typed in all the words you want to add, 
and then press the Add All button, which will add them to the word list. 

If you make a mistake you can change the word by double clicking on it, correcting it, and pressing Enter.

Removing words

Select Remove words... from the Word List menu and just type in the words you want to remove. Press 
Enter after each word to start a new line. When you've finished either press Alt+O or press the OK button.
The words will then be removed from the selected word list.

If you come across a word that you want to remove when using AutoFind or Find Word, just select the 
word in the dialog box and press delete. You can also delete a word in a crossword grid by placing the 
cursor in the word, changing its direction to the direction of the word (by pressing TAB), and pressing 
Ctrl+D.

You may find the Find Word feature useful for generating lists of words matching a particular pattern. By 
right clicking it allows you to save the list of found words to a plain text file which you can then use in the 
Word List Manager.



Viewing and Editing lists

You can view and edit the contents of a word list using the Word List Manager. Select the list that you 
want to view and edit, and click on the View button. Words in the list will now appear on the right hand 
side, with their corresponding scores. 

If it is a large word list the words will only be displayed one starting letter at a time. You can change which 
starting letter to view by clicking on the alphabet to the side.

To edit a word, just click on it with the mouse, and change the text that appears in the Edit input box at 
the bottom. You can also change the word's score. When you change to another word list or close the 
Word List Manager the word list will be updated to reflect the changes that you've made.



Adding plain text and theme word lists

It's possible to add plain text word lists to Crossword Compiler lists using the Word List Manager. If you 
are converting a plain text word list it must have the same format as the theme lists, i.e. it must have one 
word per line like this:

 First
 Second
 Third

Punctuation, capitalization and word order are not important. To add the list open the Word List Manager 
and select the word list to which you want to add it. Then select Add theme list/text file... from the Word 
List menu, and select the file that you want to add. You will then be prompted for what scores you want to
give the added words.

If your plain text list is in UNIX format (e.g. maybe if you downloaded it from the Internet) you will be 
prompted to automatically convert it.



Changing word list scores

Each of the words in a word list has an associated score. You can change the score of individual words by
viewing and editing words directly, or change all the scores in a list by selecting Change scores... from 
the Word List Manager's Word List menu.

To the scores in a word list, open the Word List Manager and select the word list whose scores you want 
to change. The select Change scores from the Word List menu. You can either change all the scores to 
a certain value, or change all the scores by a certain amount (which is usually what you want as it 
preserves the score ordering), or change scores of a certain value to another value.

If you just want to change the scores of the words that you have used in a puzzle, use the Change scores
of words in puzzle command.



Converting word lists

Crossword Compiler word lists are in a special format that cannot be used by other programs. However it 
is possible to convert to and from the Crossword Compiler format by using the commands on the Convert
menu of the Word List Manager. 

Converting a word list to a theme list or plain text

Select the word list you want to convert in the Word List Manager and then select List to plain text or 
theme list... from the Convert menu. Type in the name you want to save the converted file as and press 
Save. You will be asked whether you want to include word scores in the exported file, if so the scores will 
follow the words separated by a semicolon.If you want to make a theme list don’t export with scores. 
Without scores the list will be saved with one word on each line of the text file. If you save in the default 
folder the exported list can then be used as a theme list.

Converting a theme list or plain text list to a word list

You can convert a theme list or any plain text word list file containing one word per line (as for adding 
plain text word lists to existing Crossword Compiler lists). Select Plain text or theme list... from the 
Convert menu and select the list that you want to convert. You will then be prompted for a name for the 
converted word list, and what score you want to give its words.

Converting a scored plain text list

You can convert a plain text list of words followed by scores. The scores should be separated from the 
words by a semicolon. Select Plain text scored list... from the Convert menu and select the list that you 
want to convert. You will then be prompted for a name for the converted word list, and what score you 
want to give words in the list that don’t have scores after them.

Converting words in a clue database to a word list

You may wish to use only words for which you have clues written, in which case it is useful to have a word
list containing only words for which there are clues in the clue database.

Converting old Crossword Compiler word lists

The word lists used with previous versions of Crossword Compiler are not compatible with this version's. 
You can however convert them by selecting Old Crossword Compiler list... from the Convert menu, 
and selecting the list to convert. You will then be prompted for a name for the converted list, the score to 
give the words in the list, and whether you want to delete the old Crossword Compiler list once it has 
been converted successfully.



Character sets

Crossword Compiler can be used in many different languages, including ones that don't use the standard 
ANSI character set that is used for most West European languages. For instance Russian uses the 
Cyrillic character set and Hungarian uses the East European set. 

Each Crossword Compiler word list has an associated character set, which ensures that the words in the 
word list. are always displayed using the correct characters. This way it is possible to create Russian 
crosswords even if you are using the English version of Windows.

To make use of multiple character sets you must have support for them installed. You can do this by 
selecting Add/Remove Programs from the Windows Control Panel, selecting Windows Setup and 
clicking on the Multilanguage Support option. Click OK and Windows will install the necessary fonts.

You can change the character set used in the crossword grid by selecting Font... from the Grid menu, 
and changing the Script setting. Likewise for the clues by selecting Clue Properties... from the Clue 
menu, clicking on the Font... button and changing the script. You will probably want to use the same 
character set for the grid and the clues, but if you want to create, say, a Russian-English translation 
practice crossword, you may not!

You can change the character set associated with a word list in the Word List Manager. Select the word 
list that you want to change, and the select Character Set... from the Word List menu. Then click on the 
set that you want to use. If you check the Save as default box each new word list that you create will 
automatically use the character set that you have selected.

It's a good idea to make sure that the grid and the word lists that you are using with it have the same 
character set, otherwise the words that appear in the word list won't be displayed correctly in the grid.



Word Lists

Crossword Compiler word lists are collections of words that you can use for word finding, finding 
anagrams and filling in grids. You can have many different word lists, and use different ones with different 
crosswords, and easily change between them when you're looking for words.

There are also Theme Lists. These are fairly small collections of themed words that can be used for 
creating vocabulary puzzles or as a theme when you fill the grid. Word lists are larger collections of 
words, can be of any size, and also have a score (see below) associated with each word. The Word List 
topics in the help file refer to these larger word lists.

The program comes supplied with two word lists, but there are many optional ones that you can also use. 
You can also create your own using the Word List Manager.

Things aren't quite that simple however! Each word in the word list also has an associated score, which 
Crossword Compiler uses to find good fits when grid filling. You probably don't need to worry too much 
about the word scores, but you can change them if you like using the Word List Manager.

Each word list also has an associated character set, which gives them powerful multilanguage 
capabilities.

Word lists are stored as files of the LST file type. However you should never need to deal with the word 
files directly unless you wish to copy the file (for instance for a backup).



Word scoring in word lists

Each word in a Crossword Compiler word list has an associated score. The value of the score can be 
anything between 0 and 100. The scores are used to optimize grid filling, and to allow you to cut off words
with too low a score when you're finding words or looking for anagrams.

For example, in the default word list most words either have a score of 25 or 50. The words with 50 are 
rather more common, and are generally root words (i.e. not many -ing, -ed, endings, etc.). When you do 
grid filling, Crossword Compiler can use this information to make sure that you get far more of the better 
words in your crosswords. You could also hide all the words with a score of only 25 by setting the cut-off 
minimum score for word finding, anagram finding or grid filling to, say, 30. You can change the cut-off 
scores in the List Usage box.

The absolute magnitude of the word scores is not very important. Mostly what matters is the relative 
scores, with a word higher than another being used much more frequently (in grid filling).

In detail, the scoring of the default English word list is as follows:

 Fairly common words 50
 Less common words and word derivatives 25
 Vulgar words likely to be unsuitable for crosswords 10

if you installed for British English then
 

 Fairly common American English words 3
 Less common American English words 2

or if you installed for American English

 Fairly common British English words 3
 Less common British English words 2

Hence the default cut-off score of 5 will avoid all words that aren't used in your preferred variety of 
English.

You can change scores in a word list by selecting Change Scores in the Word List Manager



Merging and removing word lists

You can add other word lists to a word list and remove the words in one list from another list using the 
Word List Manager.

Adding other word lists
First select the list that you want to add the other lists to, then select Add other lists... from the Word 
List menu. Select the word lists that you want to add and change the score settings as desired. When 
you press the OK button the lists will be added, and you'll be shown a summary of the changes that have 
been made.

Removing words from another list
Select the list that you want to remove words from. Then select Remove words from... from the Word 
List menu and select the list whose words you want to remove. When you press OK the words will be 
removed, and you'll be shown a summary of the changes made.

If you want to modify a list but keep a copy of the original you can use the Duplicate list command on the
Word List menu, which creates a copy of a word list with a name you specify.



Word List Manager

You can use the Word List Manager to view, edit, change and create word lists. To open the manager 
select Word List Manager... from the Words menu.

The box on the left shows all the word lists that you have at the moment. Below that there is a panel 
which gives information about the selected list. To change the list information just type in some new text 
and press the Change Info button.

 To view the words in a list just click on its name, and then press the View button at the bottom or click on 
one of the starting letters that will appear in the middle. The font used for displaying the words can be 
changed under Preferences.

You can create and delete word lists by pressing the buttons at the bottom of the window, or for more 
advanced functions select one of the options from the Word List or Convert menus. For example, to 
rename a word list select Rename list from the Word List menu.

See the following for more information:

Viewing and editing lists
Creating new lists
Adding and removing words
Merging word lists together
Adding plain text word lists
Changing word list scores
Copying and filtering lists
Converting word lists
Character sets

See also the Theme Lists topic.



Crossword Templates

Whenever you start a new crossword you are given the choice of various templates to choose from. 
These are just Crossword Compiler files with settings information which you can re-use to make new 
crosswords. Having different templates saves the bother of changing the settings each time you do a 
crossword, and you can have different templates with wildly different settings for the different types of 
puzzle you create.

There are four templates corresponding to the buttons in the New Crossword window. These are called 
American, Default, Standard, and Shape. The Default template is used for freeform/vocabulary puzzles 
and Standard for cryptic or quick puzzles. The default template is also used whenever you open a 
crossword in a non-Crossword Compiler format. The standard templates aren’t listed in the New 
Crossword window, but you can still change them if you like.

Creating a new template

All you have to do is start a new crossword with one of the existing templates, change any settings that 
you want changed, and select Save as template... from the File menu. Enter a name for the new 
template and press OK. Your new template will now be added to the list of available templates for use 
when you create a new crossword.

Changing an existing template

You may wish to do this to customize some of the default templates, or just to change the settings in an 
existing template. Just open a new puzzle using the existing template, make the changes, and select 
Save as template... from the File menu. You can now select the template's name from the drop-down list,
or just type in the name of the template. You will be prompted to make sure you want to replace the 
template, and then the change will be made.

Opening a puzzle with settings from a different template

Each crossword file has its own settings information. However, you can open a puzzle with a different set 
of settings by selecting one of the existing templates when you open a crossword file. This could be very 
useful if someone sends you a Crossword Compiler file and you don't share their taste for puzzles with 
lime green squares and bright red lines!

Deleting a template

Select a template in the New Crossword window and press Delete. You cannot delete any of the four 
template corresponding to the buttons in the New Crossword window. 



AutoFind

Use AutoFind to find words to fit in the puzzle. Select AutoFind from the Words menu, or click the right 
mouse button on a square in the word slot that you want to fill. Words are found to fit in the current type 
direction, but if there is only one possible word through the cursor's square, words are found to fit in that 
direction.

For example if you had a puzzle that looked like this:

You may want to find a word to fit down the middle. Click with the right mouse button on one of the 
squares, for example, above the 'D', to pop up a list of words that fit. Simply scroll through and select the 
word you want and press Insert. If you selected the word ADMIRAL then the puzzle would look like this:

Note that compound words in the word list are not punctuated, e.g. 'OUT OF DATE' appears as 
'OUTOFDATE', as it will in the puzzle.

If AutoFind doesn't immediately come up with a suitable word you can search in any of the other word 
lists you have set up by clicking on the tabs at the top of the AutoFind dialog box. The word list that is 
used by default, and the word lists that are displayed, can be changed by selecting Change list usage... 
from the Words menu. 

To find words matching a certain pattern use the Find Word... command on the Words menu. To find a fit 
for whole sections of the puzzle (rather than just one word at a time), use the AutoFill command on the 
Words menu.

If you want to find words of various lengths that would fit in the grid you can use Shift+Alt+A, or Ctrl+Right
Mouse to bring up the Find Word dialog box set with the word pattern at the current cursor position.

AutoFind can also show only words which, when inserted into the grid, will not cause impossible letter 
combinations. To show only words compatible with their intersecting words click the button at the bottom 
left corner of the AutoFind box. The word that is compatible with the most intersecting words in the default
word list will be selected. You can show only compatible words by default by changing the setting under 
Change list usage. To show all the words that will fit regardless of the intersecting word slots just press 
the button again.

If your search comes up with a word that you want to remove from the word list just select the word and 
press Delete. It will be removed form the word list in which it was found.

The font used for displaying the words can be changed under Preferences.



Grid symmetry

You can automatically create a symmetric pattern by selecting one of the symmetry options from the 
Pattern menu. You can have normal S-Symmetry, Dual-Symmetry (Dual-Symmetry only works if you 
have a square puzzle), left/right and top/bottom symmetries.

This pattern shows Dual-Symmetry: Whereas this one only has S-Symmetry:



Find Words

If you want to find words that match a specific pattern you can use the Find Word... command on the 
Words menu.

Enter a pattern as the search word and it will find words that match, e.g.

T???SH finds THRASH, THRESH and THRUSH
AP*X finds APEX, APPENDIX and APTERYX
?*Q*P finds ACQUAINTANCESHIP, EQUIP and REEQUIP

Use * to stand for any number of letters, and ? for one unknown letter. You can also use groups of 
alternative letters, just include the group within square brackets. Use @ to stand for any vowel and # to 
stand for a consonant. Use ^ as "not" before a letter or group. E.g.

[QZ]*[QZ] finds QUARTZ, QUIZ, and ZIZZ
####### finds RYTHMS
P@#@#?LLY finds PITIFULLY and PIVOTALLY
Q^U*^S finds QATAR, QINTAR, and QOPH
CO*^[LN]ESS finds COMPRESS, CONFESS, CONGRESS, and COUNTESS

* can stand for any number of letters, including no letters. If you wish to find a word starting with an L and 
ending in an N at least two letters behind the L, you can enter *L??*N. This will find, for example, ALIEN 
which has two letters between the L and N, and ALLERGEN which has many letters between them. *L*N 
would include words like KILN in the list, where the L and N follow each other.

You can set the minimum and maximum word lengths of words to find by changing the settings in the 
relevant box.    Once you have entered a search pattern you can look in any of the available word lists by 
clicking on the tabs with the word list names.

To change the letters which are counted as vowels (the @ symbol), right click anywhere in the Find 
Words window except on the list box, and click the Set vowels...  menu item. Enter the letters that you 
want. Consonants are defined as non-vowels (e.g. # equals ^@).

If you select one of the found words you can press the Copy button to copy it to the clipboard, or if you 
used Find Word with the cursor in a suitable slot in the grid you can Insert the word directly. If you copy a 
word with the Clue Editor open you can then paste it into the Clue Editor as part of a clue.

If you want to find words to fit in the puzzle it is easier to use the AutoFind facility.

You can use '-' instead of '?' if you like (it's a bit quicker to type).

You can save the found words to a text file by right clicking on the list, selecting Save found words..., 
and entering a name for the file to save them to.

If your search comes up with a word that you want to remove from the word list just select the word and 
press Delete. It will be removed form the word list in which it was found.



Block filling

British-style puzzles, in which words are linked every alternate letter, have a regular pattern of blocks. You
can quickly fill in the basic pattern by choosing Fill Blocks from the Grid menu.

Block filling fills in every alternate block on alternate rows. There are four choices of starting position - just
select the button for the one you want.

Note that fill from (2,1) and (1,2) is not compatible with dual-symmetry.



Puzzle flipping

You can flip a puzzle to its mirror image by selecting Flip Pattern from the Grid menu. This has no effect 
other than the numbering and order of the clues, and the appearance of the puzzle. You can undo a flip 
by doing another flip. Here is a puzzle, one before and one after a flip:

You can't flip a puzzle that contains linked clues or clue squares.



Grid Font

You may change the font used to display and print the grid and clues by selecting Font... from the Grid 
menu. You are recommended to choose scalable fonts like True Type fonts for best results. To set the 
size of the font in the grid change the Size % of squares setting in the Grid Properties dialog box.

The font used for the clues is set separately in the Clue Properties dialog box. 

It's a good idea to make sure that the character set of the word list that you are going to use with the grid 
is the same as the grid font's character set, otherwise some characters may not display correctly.



Anagrams

You can search for multiple word anagrams of a given word, either from the Clue Editor or by choosing 
Anagram... from the Words menu.

If you click the anagram button in the Clue Editor the word you are clueing (or any text that is highlighted) 
will be selected automatically. If you choose Anagram... from the menu you can type in a word and press 
Enter or click the Find button to start the search. 

Partial Words: Click this tab to find all the words in the word list that can be made using only some of the
letters in the search word. The remaining letters are shown in brackets after each word. 

Contained in: Click this tab to find words that the search word is contained in. For example if the clue 
word is 'remain', it will find 'cremation', which is 'remain' plus the letters in 'cot'. The remaining letters are 
shown in brackets after each word. The words are sorted so that ones where the remaining letters form 
an anagram (like 'cto' which anagrams to 'cot'), and the letters are in order (as the letters of 'remain' are in
'cremation'), appear first.

The anagram feature finds all the multiple word anagrams of the given word up to a certain maximum 
number of component words. You can specify the maximum number of words in the List Usage dialog 
box, along with the word list that is used. If you choose a large number the search is slower as there will 
be a lot of different anagrams. Specifying a small number also makes it easier to find a suitable anagram 
in the list.

Anagrams are displayed as they are found. The words in multi-word anagrams are not sorted, but 
anagrams are found in order of word length, so you should get all the straight anagrams before the multi-
word ones.

You can abort the Search at any time by doing another search of pressing OK. The program adds 
anagrams to the bottom of the list as it finds them. If there are a lot of possible anagrams they may not all 
be found, but you should always get at least the first thousand or so. The finder will work in the 
background as you edit other clues or whatever. To bring the window to the top just click on it. You can 
leave the anagram window open. It will be reset with a new word whenever you click the anagram button 
in the clue editor.

If you select an anagram in the list and press the Copy button it will be copied into the Clue Editor if it is 
open, or to the clipboard if not.

You can save all the anagrams or partial words to a text file by right clicking on the list box, selecting 
Save to file..., and typing in a file name.



Editing the grid

This topic describes how to edit the crossword grid by hand. See the New Crossword topic for a guide to 
creating puzzles automatically, see the Create Vocabulary Puzzle topic for how to make the program build
a puzzle for you from a short list of words, or see the AutoFill and AutoFind  topics for how to put words 
into the grid.

You enter letters from the current cursor position by typing as normal. Insert black squares (blocks) by 
pressing the space bar or double clicking with the mouse. In the puzzle there are usually words going in 
two directions; to change the direction of typing press tab, or click on the direction icon on the Toolbar. 
The cursor changes to show the type direction:

          To type Horizontally

          To type Vertically

You can use the cursors to move round the puzzle, or click with the left mouse button to move to a certain
square. 

For a full list of keyboard commands see the Keyboard topic

You can fill in some of the pattern or black squares (blocks) by using the Fill Blocks command on the Grid
menu, or use a grid library to use a pre-designed grid pattern..

To automatically insert blocks in symmetrical positions select one of the Symmetry options on the Grid 
menu.

You can create irregular puzzles by removing unwanted squares from the puzzle. Press Ctrl+Delete with 
the cursor on the square to be removed. To remove all blank squares from the puzzle, select the Remove 
Blanks command from the Grid menu. This makes the puzzle only have lines around the squares with 
letters or blocks in, so giving it an irregular outline.

You can Undo editing by pressing Alt + Backspace. This moves the cursor to the end of the last editing 
action and then undoes the action. You can repeat undo a large number of times to undo whole chunks of
the puzzle. Undo does not remove interlocking letters, so your intersecting words are left intact. 

You can move words around using the commands on the edit menu, Ctrl+C to copy a word, Ctrl+V to 
paste a word and Ctrl+X to cut a word. If you want to paste in a word starting at a particular point in the 
grid use Ctrl+Shift+V, otherwise it will be pasted starting at the beginning of the current word slot.

Once you have designed the grid and put in all the words you can lock the grid to prevent accidental 
changes. Select the Lock Grid option on the Grid menu.



Print headers

Select Headers... from the File menu to specify the headers to use when you Print a puzzle.

You can have left and right headers, and below that a header that goes right across the page. The left and
right headers are half a page wide, and useful if you want to have text at the left and right at the same 
distance down the page.

You can if you wish you can have two different headers - you could then use a different header depending
on what you are printing out. Just uncheck the Both headers the same check box, and click on the 
Header A or Header B tabs to edit the corresponding headers. You can then select which header you 
want to use when you Print the puzzle.

Select justification and font styles within each header by using the buttons on the toolbar. 

When you have finished editing the headers press OK to associate the headers with the current 
crossword. Click the Save as default headers button to store your headers for use with all puzzles that 
don't specify their own headers. If you want to use the default headers with a particular crossword just 
click the Set default headers button. If you want to use non-default headers for some types of crossword 
then you can save your puzzle (with its headers) as a templates for use when you create new puzzles.

You may customize headers to provide constant text (such as your name and address) or variable data 
(such as puzzle details or date). To supply constant text, simply type that text in one of the header boxes. 
To supply variable text, use one or more of these control codes each beginning with a '%'.

%T Puzzle title %A Puzzle author
%C Puzzle copyright %I Puzzle description
%D Day of the month %W Puzzle width
%M Month of the year %H Puzzle height
%Y Year (abbreviated. E.g. '95') %N Number of words in puzzle
%% The percent sign '%' %B Number of blocks and clue squares
%P Puzzle's path and filename %F Puzzle's file name
%G Number of the page being printed

You can also insert the control codes by clicking on the book icon at the far left of the toolbar. When the 
puzzle is printed the control code is replaced with the text it represent, in the font and style that you have 
used for the control code.

Some examples:

What you want the header be What you type

12 x 15 puzzle: Sample puzzle %W x %H puzzle: %T
Antony Lewis 10/5/96 %A %D/%M/%Y
File Name: DEMOPUZ.CWD File Name:%F

The puzzle title, author, copyright and description are set in the puzzle information box. Codes are 
particularly useful in conjunction with these settings as they allow you to set the headers only once, and 
then just change the title, author, etc., every time you create a new puzzle.

Multiple headers is a feature new in Crossword Compiler 4.1. If a puzzle created in version 4.1 is opened 
with version 4.0x the headers will be lost, but otherwise the file will open correctly. If you open in version 
4.1 puzzles created with version 4.0 the puzzle will have the default headers.



Puzzle Information

Select Information... from the File menu to view information about the puzzle title, author, copyright and 
description.

The information can be used when printing (with Headers) to give information about the puzzle. 
Crossword templates can contain default information, so that, for example, every puzzle you create 
automatically has your name as the author.

See also puzzle statistics. 



Copying to the Clipboard

You can copy the puzzle, clues, solution or answers to the clipboard for use with other Windows 
programs. Select Copy to Clipboard from the File menu, and select what you want copied from the 
submenu. 

Clues and answers are copied Rich Text Format and plain text. Puzzles and solutions are copied as 
metafiles and bitmaps (at screen resolution). Which format will be used depends on which program you 
paste the data into. You can also copy to the clipboard using the Export... command on the File menu, 
which gives you more control over what is copied.

For more information see Exporting puzzles



Exporting puzzles
Rich Text - Picture - Plain Text - Web Page – HTML – Java -    File Formats

Select Export... from the File menu for a range of options for exporting puzzles to the clipboard or to a file
for use with other programs.

Select the format you want to use for export from the tabs at the top of the Export dialog box, and select 
the relevant options. Most formats can be exported to the clipboard or to a file. To export to a file just click 
the Export File... button and enter the filename you want to save as.

To save you selecting sets of settings each time you export a puzzle you can click on the Save options 
as default button to save them for the next time you export a puzzle. Click on the Grid properties button 
to adjust the grid properties.

You can export in the following formats for use with other programs:

Rich Text Format (RTF)
This is probably the most useful format if you want to use your puzzles in other Windows programs. Most 
Windows (and some Macintosh) word processors and DTP programs can read Rich Text Format, which 
gives full formatting information for the text and can contain embedded pictures of the puzzle or solution.

If you don't want your clues on separate lines but would prefer them all in one paragraph then click the 
Clues in one paragraph box. This will export in the form:

 1 Clue one – 2 Clue two – 3 Clue three...

You can customize the clue font, space between clues and the space between the clue number and clue 
by clicking on Clue Properties. If you include the puzzle or solution it will be embedded as a metafile 
picture, see below.

If you find that the clues do not copy correctly then try increasing the Number/Clue space or not having 
the clue numbers right aligned (see Clue Properties). This can happen because some programs do not 
support all the features of Rich Text Format.

Picture
You can export the puzzle or solution as a scaleable picture or as a fixed resolution bitmap. There are 
three picture formats:

Metafile: This is a scaleable Windows picture, and is probably best for most applications since it 
will resize without loss of quality.

Bitmap: These describe the grid as an array of pixels, and hence have a fixed resolution. There 
are three supported file types, BMP, GIF and TIFF.

EPS (Encapsulated Postscript): This produces a scaleable picture that can be printed to 
PostScript printers. It can also include a preview image so you can see it on screen.

You can use the picture in many graphics, word-processing and DTP programs. 

See the Exporting Pictures topic for more detailed information.



Plain Text
Plain text can be used by virtually any program on any machine, and is the most portable way to export 
the clues and answers. However plain text does not contain any formatting information, so most of the 
formatting options you have selected for the clues will be lost.

You can also export the solution as plain text. This is most inelegant, but useful as a very reliable way of 
transferring grid information. Various Internet applications take in grids in this plain text format. The 
character that is used to represent blocks can be set in the Block Char input line. Change the 
Clue/Number characters to change the letters that are used to separate the clue number from the clue. 
Select the Right align numbers option to insert a space before short clue numbers so that all the clue 
numbers finish at the same character position. Select Clues with Answers to have the uppercase 
answer word after the clue (separated by the Clue/Number characters).

Web Page

Select this option to export an entire web page. The program will automatically produce pictures for the 
crossword grid as well as an HTML file for the web page. 

Check the Clues in one paragraph box to put all the clues in one paragraph instead of each on a 
separate line. If Include font info is selected the web page will use the font you have specified as the 
clue font under clue properties. (note that this font may not be available when people view your web 
page).    Select Small inter-clue space to have clues separated by just a line break rather than a 
paragraph. Select Monochrome GIFs to use black and white pictures for the grid, which reduces the 
display time if your grid doesn’t contain any colors.

Select Export as... and enter a name for the web page. The program will create GIF files with pictures of 
the grid and put them in the same folder as the web page. Be sure to put the GIF files on your web server 
along with the HTML file. The GIF file names will start with the same letters as the main web page's file 
name. See the HTML Templates topic for how to create your own templates for the web page that is 
produced.

HTML
Select this option to export clues or answers formatted as HTML for use in other web publishing 
programs. Click the Copy to clipboard button to copy the item you have selected and then paste into 
your other program. The options are explained under Web page export above.

Java
Select this tab to export a web page with an interactively solvable puzzle. You can then put the puzzle on 
your web site for people to solve in their web browser. See the Exporting Java Crosswords topic for more 
information. 

Crossword Compiler comes with the applet you need to put interactive puzzles on your web page. The 
applet may be freely used on public web pages provided the owner of the web site owns a licenced copy 
of Crossword Compiler.

File Formats
You can export puzzles in various file formats for use with other crossword software.



Across™ Format

Use this option to convert puzzles to Across format PUZ files. (tm)Across is a puzzle solving package 
available on the Internet from http://www.litsoft.com.

The Restrict Solution option does not put the solution letters into the file, so the solution is absolutely 
secure (useful for competition puzzles). The Scramble solution option merely encodes the letters, 
and can be revealed using the code number given once you have converted the puzzle.

Maestro format

Use this option to convert puzzles to Crossword Maestro format .CMO files. Crossword Maestro is a 
solving program, more information is on the Internet at http://www.genius2000.com. Please mention 
Crossword Compiler if you purchase the program.

The Restrict Solution option doesn't include the solution letters in the file, so people can solve the 
puzzle without being able to cheat. Select Cryptic crossword to make Crossword Maestro's clue 
solver work in cryptic mode. Select Barred crossword to flag the puzzle as being barred.

Crossdown format

Crossdown is a solving and compiling program. Crossdown only supports a limited number of square 
grid sizes.



Reviewing and Editing clues

You can view and edit clues by selecting Review Clues... from the Clue menu, or by using the keyboard 
shortcut Ctrl+R. The clues are shown in a scrollable list, with the clue number at the left, and the solution 
to the right. 

For more powerful editing features double-click on a clue and the Clue Editor will appear.

If there are incomplete words in the puzzle the solution appears with question marks for the missing 
letters. You can only edit clues for complete words.

You can spell-check the clues by pressing F7 or clicking the tick button on the tool bar. For each word that
the spell-check finds you can type in a replacement, ignore it or add it to the word list. Set the word list to 
use for spell checking in the List Usage box, which you can view by clicking the Options... button on the 
spell-check window.

It is a good idea to review the clues before you Print them to check you haven't missed any clues, or that 
any words are incomplete. It also makes a convenient way quickly to edit the clues if you don't need all 
the features of the clue editor.

You can resize the Review Clues window to better fit your screen by dragging the bottom right hand 
corner with the mouse.



Keyboard control and shortcuts

Keyboard controls when editing a puzzle:

Cursors Move the cursor

Shift+Cursors Select squares

Ctrl+Cursors Skip to next or previous word start

Alt+Cursors Insert/remove a bar on a side of the square

Tab Toggle the direction in which you want to type

Enter Move to left or top of next line

Spacebar Insert a default Block

Delete Delete letter/block at cursor

Ctrl+Delete Remove square from puzzle

Shift+Delete Delete word. Doesn't affect intersecting words

Alt+Delete Delete letters, but not blocks, in current selection

Alt+Backspace Undo

Alt+Enter Edit a square's properties

Ctrl+A AutoFind 

Shift+Alt+A Find word    to fit in word slot

Ctrl+E Edit Clue 

Ctrl+R Review/edit clues

Ctrl+W Show WordWeb with the word at the cursor (if you have WordWeb 
installed).

Ctrl+C Copy word at cursor to clipboard

Ctrl+X Cut word at cursor to clipboard

Ctrl+V Paste word at start of current word slot

Ctrl+Shift+V Paste word starting at the cursor position

Ctrl+L Select word in the current word slot

F1 Help Contents

Ctrl+S Save



See Mouse for mouse combinations and the Toolbar topic



Mouse

Left Button Move the cursor to the square clicked on

Ctrl+Left Button Select more squares without loosing current selection

Double Left Button
 On a squareclicked on
 On a line

Insert default block in square 
Insert a bar

Alt+ Double Left Insert the alternate block type (Clue Square or Block)

Right Button
 On a letter square
 On a block square
 On a clue square
 On a picture

AutoFind words to fit in slot clicked on
Show the square properties
Edit the clue square
Show the picture's properties

Alt+Right button On a letter square: AutoFind words to fit in the word slot in the 
opposite direction.

Ctrl+Right button On a letter square: Find Word to fit in word slot

The default block type is set in the Advanced page of the Grid Properties dialog box. It can either be a 
normal block or a clue square, in which case the alternate block type is the other one.

You can also disallow double left-clicks from making bars or blocks in the Grid Properties dialog box. This 
is sometimes useful as it can be hard work aiming exactly at a narrow line!

See Keyboard for keyboard shortcuts, and the Toolbar topic.



About Crossword Compiler

Selecting About... from the Help menu brings up a dialog box showing copyright and version information.
The date of the version you are using is shown in the bottom left hand corner. 



Opening an existing file

Open an existing crossword file by selecting Open... from the File menu. Enter the name of the file to 
open, or select the folder and file from the list boxes and press Open.

To open a file with a different set of settings you can open a puzzle using the settings from one of the 
available crossword template.

You can open files in Crossword Compiler format,    "Across" PUZ format, "Crossword Maestro" CMO 
format or Crossdown XWD format. 

Files that you have edited recently can be reopened by clicking on their file names at the bottom of the 
File menu.

Plain text import is also supported. Select the Plain Text option in the Files of Type box. The format of the
text file is fairly flexible. The program can open files in the plain text format exported by Crossword 
Compiler, the plain text Across format, and various other plain text formats. It expects grid data first, 
followed by clues. The clue numbers are ignored, clue linking is not supported, English language is 
assumed and no error-checking is performed. So you should check the opened puzzle carefully to make 
sure everything is as you expect!

If you wish to open a puzzle just to print it out for solving purposes you can hold down the Shift key when 
you open a puzzle. This shows the crossword in puzzle view so that you cannot accidentally see any of 
the solution words.

You can also hold down the Ctrl key when opening a puzzle in order to test-solve the puzzle on screen. 
This replaces the letters in the grid with question marks, so you can view the clues without seeing the 
solution.



Save As

You can give a puzzle a name, or save under a new name by selecting Save As... from the File menu. 
Enter the name for the puzzle and press OK. You can select a different folder or save to a different disk as
you like.

You can save a puzzle with its current name by pressing Ctrl+S or selecting Save from the File menu.

To save a puzzle for use with other programs use the Export feature.



Save

Select Save from the file menu or press Ctrl+S to save the puzzle with its present name. If the puzzle is 
untitled the Save As dialogue box will open for you to choose a name.



Printer Setup

Select Printer Setup... from the File menu to select and setup a printer for Printing. Select the printer 
you want from the drop down list. You can press the Properties... button to set other options for the printer
selected. You can also change the printer setup from the Print dialog box.



The main toolbar

The toolbar is the array of icons at the top of the program window. By clicking on them with the mouse 
you can quickly invoke the command they represent. You can hold the mouse cursor over a button for a 
short time to pop up a hint that tells you what the button does.

Here is a complete description of all the buttons:

      Get Help

Show the New Crossword window

Open an existing file

Save the crossword

    Invoke AutoFind 

Fill Automatically from cursor

Toggle the typing direction 

Undo last change. Can be used multiple 
times.

Edit Clue

Review/edit clue list

Edit Square properties

See Editing the Puzzle for more information on undoing and type directions.



The Clue Editor

To edit the clue for a particular word in a puzzle press Ctrl+E with the cursor on the word for the clue you 
want to edit. You can also click on the Edit button on the Toolbar. 

If there are two words through the letter at the cursor, it will select the word in the current typing direction 
(press Tab to change the type direction). You can only write clues for a complete word, i.e. one terminated
by a block, bar, or the edge of the grid. If you create a freeform puzzle by typing in words without blocks 
or bars use Remove Blankson the Grid menu before writing clues.

Once you have finished writing the clue press Enter to close the dialog box, or click on the arrow button to
edit the next clue. The clue number is displayed in the title bar of the dialog box and the clue word is 
displayed below that. There is a large input box for entering the clue and input lines for entering the 
format and an explanation/citation for the clue.

For cryptic puzzles, use "Explanation/citation" to explain the clue's wordplay--for example, '2 defs'. For 
non-cryptic puzzles, use "Explanation/citation" as necessary to tell someone else (an editor, perhaps) 
where to verify either an unusual answer or its definition.

Here's a summary of the clue editor commands. You can also call most of them by clicking with the 
mouse on the buttons at the top of the dialog box:

 
Enter Close editor, saving changes
ESC Close editor without saving changes
Alt+> or Ctrl+N Move to next clue, saving changes
Alt+<    or Ctrl+P Move to previous clue, saving changes
Ctrl+D Delete the clue
Ctrl+K Link the clue
Ctrl+A Find Anagrams
Ctrl+F Find Word
Alt+U Use the clue found in the Clue Database
Ctrl+L Display list of    Letter Indicators
Ctrl+G Display list of    Anagram Indicators
F1 Bring up this help screen
Ctrl+W Show WordWeb Pro (if you have it)

There may also be buttons for looking up the word in custom dictionaries. 

You are advised to finish designing and putting words in the grid before starting to write clues. You can 
then systematically write each clue in order so there's no chance of missing a clue or writing a clue for a 
word that you will change later. Once you have finished you can review the clues by selecting 
Review/Edit Clues from the Clue menu. Alternatively you can write the clues quickly using Review/Edit 
Clues as long as you don't want to use any of the advanced features of the clue editor.

Editing the Clue

To edit the clue, or write a new one, simply type the clue in the Clue editor box. You can use bold, italic 
and underline in a clue by pressing respectively Ctrl+B, Ctrl+I and Ctrl+U, or using the buttons on the 
toolbar.

You can also insert various special symbols into the clue by right clicking, selecting the Insert option and 
then Symbol. Just select the symbol you want inserted.



You can change the format of the solution by entering the format in the Word Format input line.

If you click on the Anagram button or one of the dictionary buttons the current clue word will be 
anagrammatized or looked up in the dictionary. You can also select any portion of the clue word, or part of
the clue, and then click on the button. This will then use the selected text instead.

Editing order

You can change the order in which you edit clues in the global preferences dialog box.



Word Format - Automatic word length

Do not include the length, or format, of the clue in the clue editor, but in the Word Format input line. By 
default this is just the number of letters in the word, which is entered automatically. However if the 'word' 
is hyphenated, or more than one word, you can enter the format here. Just type the number of letters in 
each word, or hyphenated half word, and a comma to indicate a new word or a hyphen to indicate a 
hyphen. The format is then automatically included in brackets at the end of the clue you print it. The word 
is also correctly formatted in the dialog box and when you print the answers.

For example if the word is displayed as ONTOPOFTHEWORLD (On top of the world), then type 
'2,3,2,3,5' in the format line. On pressing tab the correctly formatted word will appear at the top of the 
dialog box. If the clue is linked then enter the format for the linked solution.

You can select to either add the format to the end of the clue or not by selecting the Print solution 
lengths in the clue properties dialog box. Most British cryptics do have the format, most American non-
cryptics don't.



Printing a puzzle

Select Print... from the File menu to print the crossword. A dialog box is displayed showing the various 
print options. Check the check boxes for what you want printed.
 
Headers

This prints the headers you have selected in the Headers dialog box, with the relevant information about 
the current puzzle inserted. You can select the Header A or Header B to choose which header to use if 
you have multiple headers available.

Puzzle, solution and numbered solution

Self explanatory. The numbered solution has the solution letters and the grid numbers. Select Print on 
separate page to print the solution after the puzzle and clues on a separate page.

Clues and clues with answers 

You can choose to print just the clues, in which case they are printed in two columns, or you can print the 
clues with answers — clue on the left and the solutions on the right (as when you review the clues). Extra 
formatting options for printing clues can be set in the Clue Properties box.

Code grid and Code solution

These are only available if you have a coded grid (numbered by letter). These options print out a blank 
and completed grid of letter-number relationships.

Headers on each page prints the headers at the top of every page printed, not just the first

Separate pages prints each item you have selected on a separate page

Use hashed blocks can be useful if you want to speed up printing on a dot matrix, or stop the paper 
getting soggy on an InkJet.

Print to file

Select this option if you want to save the print output to a file for printing later or sending to someone else.
If you select this option you will be prompted for a file name when you start printing.

Collate will collate the pages and is only available with some printers

Copies determines how many copies of each page are printed. With some printers it's advisable not to 
print too many at once or you may find your memory and disk filling up.

Printer Setup show the Print Setup dialog box.

If you try to print the clues before you have written any, the program will print out the clue numbers with a 
blank space next to it. This is useful if you like to work to a hard copy when writing clues. You can then 
type in the clues when you are satisfied with them.

Note that very large puzzles may not fit on A4 paper. You will be asked whether the square sizes should 
be shrunk to make it fit if the puzzle doesn't fit. To change the margins choose the Page Setup... 
command from the File menu. You can change the printer by selecting Printer Setup... on the File menu.



You can save your settings for printing by pressing the Save options button. The settings will be saved 
for the next time you print out a puzzle.

Printing the puzzle uses all the settings set in the various property dialog boxes.
See Grid Properties, Font and Clue Properties for more information.



Word List Usage

Select Word List Usage... from the Words menu to set and change the way the word lists are used in the
current crossword. There are four pages of options, click on the tabs at the top of the dialog box for the 
page you want.

Select word lists

The available word lists are shown on the left, and the ones to used for word finding with this crossword 
on the right. If you select the Use all check-box, all the available lists will be used. The word lists shown 
on the right are the ones you will see when you find words or invoke AutoFind.. Unless you have a very 
large number of word lists you will probably find the Use all option the most useful.

Anagrams

Select the word list you want to use for finding anagrams in the List to use combo-box. The anagram 
finder will not use words with a score less than that specified in the Minimum word score entry. The 
Maximum number of words in anagram option lets you put a limit on the type of multi-word anagrams 
that are found. 

Word Finding

Use this page to set further options for word finding, based on the word lists you have selected in the 
Select word lists page. The word finding features will not find words with score less than that specified 
under Minimum word score. Change the Maximum number of words to find to prevent the program 
spending ages finding thousands and thousands of matches for an un-restricting search. Select the last 
check box if you want AutoFind to show only words that will allow you to find words that fit in the 
intersecting word slots. This is useful as it ensures that a word you find using AutoFind will not 
immediately generate a letter combination in the grid which no words will fit.

Spelling

Select the word list to use for spell-checking clues in the Review/edit clues box, and for checking the 
words in the grid (listed in the puzzle statistics box). Words with scores less than the Minimum word 
score will be counted as mistakes. You can choose to Ignore words shorter than a certain length, 
ignore words starting will a capital (except ones at the beginning of clues), or words that are in uppercase.

You can change which word lists are used for AutoFill in the Fill Grid dialog box.



Linking clues

It is possible that you have two or more words in the crossword for which you wish to write a combined 
clue. For example, if somewhere in the puzzle there are the two words PREGNANT and PAUSE you may 
wish to write one clue for the phrase 'PREGNANT PAUSE' rather than two separate clues. To do this use 
the Link Clues dialog box.

You can show the Link Clues dialog box by selecting Link Clues... from the Clue menu, or by pressing 
the Link Clues button in the Clue Editor. If you use the clue editor and the word you are clueing is already 
linked you must first clear the current links before making a new set.

The Link Clues dialog box

The left-hand side list-box shows all the words in the crossword which aren't currently linked. Select the 
first word in the phrase you want to link and press the > button. Then the next one, and so on. The words 
you are linking are shown on the right, in the order you linked them. The linked word is displayed at the 
bottom of the dialog box.

To change the order of a word in the linked phrase, select the word and click on the arrows are the right of
the dialog box to move it up or down

The linked word is shown using the format in the Word Format input-line. You can change this to correct 
the punctuation of the linked phrase.

The Clue number text entry is automatically set every time you add a word to the linked phrase. Once 
you have the phrase linked as you want you can change this entry as you link. The clue number text is 
the text used for the clue number when printing, e.g.
By default it might be

2/3/6/7D      This is the clue

and you could change '2/3/5/7D' to '2,3,5 & 7 Down' to make it appear as

2,3,5 & 7 Down      This is the clue

Once you are satisfied with all the setting you can close the dialog box, or, to set another set of links, 
press the Set links and select new set button.

To delete a set of links, put the cursor on one of the linked words, bring up the clue editor and click the 
Link Clues button ( ). You will be prompted to clear the link.



Crossword statistics and checking for similar words

Select statistics from the File menu to show statistical information about the current crossword. You can 
also select Words and word statistics from the Words menu to show the Words page of statistics 
directly. There are three pages of information:

General 

This shows various self-explanatory statistics.

The program calculates whether the grid is pangrammatic (containing all letters of the alphabet) using the 
alphabet selected under Clue Properties . It is not classed as pangrammatic if any of the letters are 
missing or the grid contains letters not in the alphabet. 

Words 

The left list box shows an alphabetical list of all the words in the puzzle. Click on any word to select it in 
the grid. The right list box shows a graph of word length frequencies - click on any line to select words in 
the grid that are of that length.

Click the Select words not in spelling list button to highlight words which aren't in the word list you've 
set up for spell-checking. The word list is set in the List Usage box. If some of the words are incomplete 
(i.e. show up with "?" in place of some letters) the program will highlight the words which have no 
matches in the spelling list.

Similar words 

The list box shows any words in the grid which contain common groups of letters. The common group of 
letters is colored in red, and words with the most number of common sequential letters are listed first. This
is useful for checking that you are not using words which a too similar, even though they're not exactly 
identical. Click on any line to select in the grid the words listed on that line.



Removing Blanks

To remove all squares in the puzzle with no letter or block in, select the Remove Blanks  item on the 
Grid menu.

Removing blanks gives the puzzle an outline that goes round every filled square, allowing you to create 
free-form puzzles. You can toggle a square between being removed and blank by pressing Ctrl+Delete 
with the cursor on the square. Here is an example of a puzzle before and after removing the blanks:

Delete all letters

Select Delete all Letters from the Grid menu to clear all the letters in the grid leaving a blank grid. If you 
have written some clues for the words you are clearing they will also be deleted. If you choose to clear the
clues they will be lost for ever, however you can replace the letters you cleared by using the undo button 
on the Toolbar.

You can use Delete all Letters to extract a blank grid from a puzzle you or someone else has already 
written, saving you the trouble of creating a new grid.



Page Setup

Select Page Setup... from the File menu to change the margins used when the puzzle is printed.

All measurements are in centimeters.



Using AutoFill to fill a crossword

You can fill in complete puzzles, or sections of puzzles from a word list using the AutoFill command on 
the Words menu. You can also click on the AutoFill icon in the Toolbar or press Ctrl+A.

AutoFill fills in the grids with the default settings in the Fill Grid dialog box.

For more information about grid filling see Filling words in a crossword grid .



Filling words in a crossword grid

Select Fill Grid... from the Words menu to bring up the Fill Grid dialog box with options for filling in the 
word slots in a grid. If you just want to fill the grid using the default options use the AutoFill command.

An example

If you had a crossword that looked like this:

you could place the cursor next to the 'E' in 'STICKER', and invoke AutoFill or Fill Grid, to get a complete 
crossword. For example

You can also fill in a totally blank grid, but you must finish designing the pattern of blocks before using Fill 
Grid (see the edit topic for help with this, or use a Grid Library). If you want to let the program design the 
grid and use just a short list of words then use the Create vocabulary puzzle feature instead.

See The Professional Grid Filler topic for details of advanced options and manual word selection.

Filling the grid
During the fill

Once you have set the options press the Fill button, and the fill will begin. You can cancel at any time by 
pressing the Cancel button, or stop the fill, keeping the filled letters, by pressing Stop. Click the Menu 
button for a menu with more options.

If a fill seems to get stuck in one part of the grid or you don’t like a letter that has been used, you can 
select Refill from beginning on the Menu button to start the fill again from the beginning with a different 
random start word.

Select  Refill with new options from the Menu button to cancel the fill and change the options for the fill.

If you wish to fill more than one grid simultaneously you can change the relative priorities of the two fills 
by changing the Fill priority menu setting. If you want to carry out a difficult fill whilst doing something 
else you may also want to lower the priority to make sure that whatever you are working on is more 



responsive.

When the fill is completed

Once the fill is complete you can either press the Accept button to accept the fill, Cancel to abandon the 
fill, or click on the Menu button for other options. The Words used menu item will show the words used 
window with a list of all the words in the grid and give you an option to restart the fill from/without a 
specific word. Select the Check similar words menu item to analyse the words in the grid for repeated 
sequences of letters. This is useful if you want to avoid using two words that are similar but not identical.

Use the < and Next > buttons to move between successive fills. Pressing the Next button will find the 
next possible fill. With many grids this will mean just changing the last few words used. However if you 
are filling a tight corner this can be useful to quickly view all the possibilities. If you have created several 
fills, either by pressing the Next button or by using refilling parts of the grid you can view previous fills by 
pressing the < button.

Options
Change the following options in the Fill Grid window to customize the filling process and set the default 
settings for AutoFill.

Base word list

Select the word list that you want to use in the Word List to use list box. The words in this list that will be 
used for filling the grid (but see 'using theme words' below).

Optimization

Each of the words in a word list has an associated score. By using the optimization options you can vary 
the number of 'good' and 'bad' words filled into the crossword. Weak optimization is quite fast, and will 
give you a significantly higher average score than using no optimization. Strong optimization will give you 
a significantly higher average score than weak optimization if your word list contains only a few highly 
scored words. Set optimization to Theme Words if you want to create a thematic crossword. Select Fill 
reliability if you have a particularly hard grid to fill. This makes the fill progress more slowly, but with 
difficult grids the fill may finish sooner that with the other optimization options.

Change the Minimum word score setting to avoid words with scores less then this score. This allows 
you to avoid obscure words altogether if you want to. (see the topic on word scores for more information).

Using theme words

The grid filler can try to maximize the number of theme words that are filled into a grid. Set the 
Optimization option to Theme Words and select a Theme List or main word list to use as a theme.

The filling program will use as many of the theme words as it can, but when it can't use a theme word it 
uses a word from the Word List to use. This is a good way of creating a themed crossword when the 
theme word list contains too few words to fill the grid directly.

Select Weak theme only to use fewer of the theme words if you want only a few theme words.

Pangrammatic fill

Select this option to ensure that the filled grid contains every letter of the alphabet. The alphabet used is 
set in the Clue Properties dialog box. The filler will only use words containing letters of the alphabet, and 
each letter will appear at least once in the completed grid.



Save as settings for AutoFill

Select this option to save your options as those used for AutoFill and as the default settings for the next 
time you use Fill Grid. Fill settings are stored with each puzzle. You can then save the puzzle as a 
template if you want to use your settings for crosswords you create in the future.

For maximum control over which words are used in the grid you may prefer to use AutoFind repeatedly, 
and choose exactly which word you want in each word slot yourself, or you if you have the Professional 
Grid Filling module you can select Manual word selection to have complete control over which words 
are used.



Clue Databases

Clue databases allow you to database clues from puzzles that you have written, or to store your flashes of
inspiration until the word comes up in a crossword. You can open a clue database, or create a new one, 
by selecting Open/create Database... from the Clue database submenu of the Clue menu. 

You can add clues from puzzles to the database using the Add clues from puzzle command. This will 
add all the clues in the current crossword to the database, though any formatting information in a clue will 
be lost (e.g. bold, italic). 

You can view the clues in the database and add and delete clues from the database using the Database 
Manager. 

When you edit a clue using the Clue Editor you can insert clues from the database. The default clue 
displayed in the Clue Editor is determined by the Default Database Clue setting in the Preferences 
dialog box. It can either be the most recently added clue, the oldest clue, or one chosen at random.

You can add clues from one database to another database using the Merge Databases... command. This 
should save you from re-entering all the clues if you already have a database on computer (databases 
from previous versions of Crossword Compiler are 100% compatible).

The database used with a given crossword is saved with the crossword. To save your database settings 
for future crosswords, save the current crossword as a template.

Crossword Compiler clue database files have the .CDB extension, and are in the format of keyword in 
capitals, space, then the clue. Each entry like this is on a separate line, with the oldest clues for a given 
word being listed first. E.g.

 WORD Oldest clue
 WORD Newest clue (Format) \(Explanation)



The Clue Database Manager

Select Database Manager... from the Clue Database submenu of the Clue menu to display the manager
for the currently selected clue database.

To view clues in the database select the starting letters of the word whose clues you want to view. Then 
select the word, and the clues in the database will be displayed in the bottom panel. You can delete a clue
by pressing Delete, or edit a clue by double clicking on it or pressing the Edit Clue button.

To add a clue to the database select the Add button. Type in the word you want to write a clue for, tab 
down to the clue box and type in the clue. You can also add an explanation and clue format. Press OK to 
save the clue, or New to save the clue and enter another one.

When you have finished viewing and editing the database click OK to save the changes you have made 
or Cancel to abandon them. If you click OK updating the database may take a while if it is very large — 
please be patient.



Merging clue databases

You can merge clue databases together by using the Merge Databases... command on the Clue 
database submenu of the Clue menu. Just select a database whose clues you wish to add to currently 
selected one. The currently selected database is set in the Open/create database dialog box. 

If Crossword Compiler did not create the database you are merging in you should check that the 
database is in the following format:

      WORD Clue after a space

Each clue should be on a separate line, and they must be in strict alphabetical order. You cannot merge in
non-Crossword Compiler databases if they contain non-English characters in the databased words.



Introduction to Cryptic Crosswords

Cryptic clues are very popular in Britain, and have a following in North America. In cryptics, unlike 'quick' 
or American crosswords, the clue has a cryptic part in addition to a definition part. This makes them 
harder to solve, but there should be no ambiguity about whether an answer is correct or not. The cryptic 
part of the clue consists of some instructions on how to put together the answer from its letters, a play on 
words, or some other quirk. Here is an explanation of some of the more common clue types, though in 
practice many clues will be a combination of these simple types:

Double Definition

Here the clue consists of two parts, both of which are synonyms or definitions of the word. E.g.

    Calling charge (6)      

=CAREER, calling (meaning job) and charge (as in to charge round) both mean career, though not in the 
meaning first implied by the clue.

Likewise 

 Money-lust (3) = YEN Cook fish (3) = FRY 

Anagram

This consists of two parts, an anagram of the word and a definition. Often the anagram is indicated by 
some Anagram Indicator, meaning 'mixed up', 'shuffled' or whatever. E.g.

    Platter to cook waffle (6)

=PRATTLE, anagram of 'platter', meaning to waffle. 'To cook' indicates the anagram, though more 
properly 'to cook' would be before the anagram. However misplaced indicators, or completely omitted 
indicators, are quite common.

Likewise

 Rioted to get control of news! (6)

 = EDITOR, an anagram of    'rioted'. The anagram indicator here is 'rioted', which is also the word to be 
anagrammed, hence the exclamation mark that usually indicates some overlap in the clue.

Reversal clues are special cases of anagram clues, where the anagram happens to be just the word 
backwards. In this case it would be indicated by some word such as 'back' or 'rising'.

Hidden Word

Here you can find the word in the middle of the clue. It is normally indicated by some word like 'inside'. 
E.g.

 Uncover a veneer, inside is black (5)

=RAVEN, meaning black. The word is hidden in 'UncoveR A VENeer' .

Homophone



This is where the cryptic part of the clue leads to a word that is pronounced the same as the answer but 
spelled differently. It is usually indicated by some word or phrase like 'we hear' or 'reportedly'. E.g.

 Heard the branch bend (3)

=BOW, meaning 'bend', a homophone of 'bough' (meaning 'branch'). These type of clues can turn into 
more of a pun, where the clue is followed by a question mark:

    Poem heard from soprano pigeon? (5)

=HAIKU, a Japanese poem, pronounced roughly as 'high-coo'.

Charade

The clue spells out the parts of the word. E.g.

 Failed English dandy (4)

=DUDE, meaning dandy. Failed=DUD, English=E (this is a standard letter indicator for the letter E), hence
DUD+E=DUDE.

Often these have more than two parts.

Container

The clue instructs you to place some letters inside others, producing the word. E.g.

 Complain when club admits the French (5)

=BLEAT, meaning complain. Club=BAT, the French=LE (using foreign words like this is another standard 
trick), admit 'LE' to the middle of 'BAT' and you get 'BLEAT'.

? clues

The '?' is used to indicate some pun or weirdness in the clue. It can be used on almost any clue that 
doesn't follow the usual forms of clue. E.g.

 Meeting needed to make pear juice? (5,10)

=PRESS CONFERENCE, you need to press conference pears in order to make pear juice.

 Park? (6,4)

=COMMON NOUN, 'park' can mean a common, and is also a common noun. 

It is used in 'backwards clues', where the answer to the clue could be a clue itself, e.g.

    Wot, wot ?(3,4)

= TWO FOLD, if you take 'two' and 'fold'    it you get 'wot' . 'Wot' occurs two fold in the clue. Likewise

    Draw? (8)

=BACKWARD, 'draw' ='ward'    back(wards). These clues do not have a definition part. This is usually only
acceptable if the clue has some other particular merit.



'!'    clues

Like the '?', the exclamation mark is sometimes used to indicate something unusual. However usually it 
indicates some overlap in the clue, where say the word to be anagrammed also forms part of the 
definition. An example is

    It's in hearing! (3)

=EAR, 'ear'    occurs in 'hEARing'    and if you are in hearing your ear certainly is!

or how about

 Damn! (9,4)

=CROSSWORD CLUE (it's a cross-word clue!).

The exclamation mark is also used very occasionally in ultra-short clues, e.g.

    L! (4,3) = TAIL END or J!(4,5) = JUMP START

The clues lack any definition part, and the '!'    could equally well be replaced by a question mark. Clues 
without any definition are frowned upon my some crossworders.

Indirect Anagram

These clues are like anagram clues except that the anagram is not given explicitly and must be deduced 
from a synonym or whatever. This type of clue is very difficult unless the word is very short, and is 
frowned upon in many circles. E.g.

    Find hole in tangled string (4)

=PORE, meaning 'hole', an anagram of 'rope' which is itself a synonym of 'string'    

    Must go round garden (4)

=NEED, anagram of 'EDEN', a garden.

Others

There are numerous other varieties of clue, most of which are used in special crosswords where the 
solver is told about the type of clue used. For example in misprint clues, where a part of the clue has been
misspelled, the misspelling must be corrected before the clue can be solved. E.g. the definition part of the
clue may be 'harp', but it would appear in the clue as 'hard'. This makes everything much trickier!

Further reading

See the bibliography



Crossword Glossary

Afrit's Law The injunction for Ximinean cryptic clues that 'you need not say 
what you mean, but you must mean what you say'

Barred grid A grid in which thickened lines, as opposed to blocks, mark the end 
of words

Crosswordese Words excavated from obscure dictionaries that are only ever seen 
in crossword grids.

Cruciverbalism Crossword study or general wordsmithism

Light A word in a puzzle which is to be clued

Pangrammatic Pertaining to grids which contain every letter of the alphabet

Unch A letter in a light that does not intersect with another light—an 
unchecked letter.

&Lit A cryptic clue where the entire clue is also a 'literal' definition of the 
light.

Ximinean Pertaining to a type of 'square dealing' cryptic clue containing a 
definition and secondary cryptic definition which can be decoded by
an exact interpretation of the grammar in the clue.



Bibliography and further reading

There are many good books on solving crosswords, so I shall just mention two book related to crossword 
compiling that are still in print.

Random House puzzle maker's handbook by Mel Rosen & Stan Kurzban
ISBN 0-8129-2544-0

This is an excellent all round study of crosswords, from solving quick definition crosswords to constructing
cryptic clues. It also covers many of the variants like acrostic and diagramless puzzles. The book has a 
slight American bias but it is not a real problem. American readers may find the guide to marketing 
invaluable.

Chambers Crossword Manual by Don Manley
ISBN 0-550-19034-1

This book is dedicated entirely to cryptic clues and covers everything from the simplest cryptics right up to
the (in my opinion!) completely unsolvable advanced cryptics. It has a strong British bias in places, and a 
lot of the book is taken up with example puzzles. There is lots of useful advice and clue criticism, but you 
might like to take his harsher strictures with a pinch of salt.

If you have an Internet connection you may find the rec.puzzles.crosswords newsgroup of interest. 
There are regular clueing competitions, and general discussions of anything relating to crosswords. There
is also a crossword discussion list at www.cruciverb.com. This is also an excellent site for other 
information of interest to the serious crossword constructor. 
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Customer support and upgrades

Contacts for customer support:

 E-Mail: compiler@x-word.com
 Post: Antony Lewis, 16 Townley Rd, London SE22 8SR, UK.

The Crossword Compiler users' page on the World Wide Web is at http://www.x-word.com/users.html. 
Minor upgrades are also available for download on the same page.

Information about WordWeb is available on the Internet at http://www.x-word.com/wordweb/.



Changing the scores of words in a puzzle

If you regularly create puzzles using the same word list you might like to avoid words that you have used 
before. You can do this by changing the scores of the words in the word list each time you have made a 
puzzle. Alternatively you might want to add words in a puzzle to a word list. 

To do these things select Change scores of words in puzzle from the Words menu and select the word 
lists that you want to change. You can either change the scores by a certain amount, or set the scores to 
a specific value. 

By setting a fixed low score for the words' scores you can cut them out of future grid fills completely by 
setting the minimum cut-off score to above the score which you have given the words.

By just decreasing the scores by some amount you can ensure that AutoFill and Fill Grid give a low 
priority to words that you have used most often before.

Click the Add words not in list box to add words to the list as well as changing the scores of words that 
are already in the list. If you just want to add words without changing the scores of words already in the 
list you can set the Change scores by setting to zero.



Deleting blocks

Select Delete all blocks from the Grid menu to delete all the blocks (black squares) in the puzzle.



Puzzle Views

When you edit a grid as much information is shown as possible as regards square colors and settings, but
no clue numbers. Select View from the Grid menu to preview what the puzzle and solution will actually 
look like.

Some square properties depend on whether it is the solution or puzzle that is being viewed, so it is a good
idea to use the view feature to make sure everything works correctly in both views.



Close

Select Close from the File menu to close the current puzzle. You can have many puzzles open at once, 
and Close only closes the topmost one.



Exit

Select Exit from the File menu to close Crossword Compiler. You will be prompted to save any changed 
crosswords that are open.



Adding images to a puzzle

It is possible to place pictures in various positions in the crossword grid. Select Paste image... from the 
Edit menu to insert an image from the clipboard, or Insert image file... to insert an image from a file. You 
can insert either a bitmap or a Windows picture (metafile). You will be prompted for some options for 
pasting the image.

The Left Square and Top Square options determine the co-ordinate of the top-left of the image in the 
crossword grid. Set the Squares Wide and Squares High to the width and height (in grid squares) you 
want the image to have. It must cover an integral number of squares.

Check the Add Border box to have a line around the image.

The Arrow settings allow you to add a little arrow coming from the image, useful in conjunction with a 
clue squares crossword. Grid X sets the left square that you want to have the arrow, Grid Y sets the right 
square. You can choose which direction you want the arrow to point in.

You can change the image's properties once it is in the grid by right clicking on it with the mouse. You can 
also delete the image this way.

You cannot undo adding and removing images.



Grid Properties

Select Grid Properties from the Grid menu to change various settings for how the grid is displayed and 
edited. You can also edit the grid properties when you are exporting by clicking on the Grid Properties 
button in the export window. 

The dialog box displayed has two pages of settings, standard and advanced. When you have changed 
some properties you can see the effect by clicking on the Apply button.

Colors

Change these settings to affect every square in the grid that has default color settings. Use the Square 
Properties dialog box to change the colors of individual squares. You can choose a custom color by 
selecting the Custom item, which will then show a window allowing you to choose any color in the 
spectrum. Note that custom colors may not show on screen exactly as they should if your screen setting 
is less than 16 million colors . The Line color is setting is used for the grid lines and bars. Check the 
Thick puzzle border box to make the outside border of the crossword thicker (the thickness of a bar).

Square Numbering

Change this setting for how all the squares in the grid are numbered. Normal is the standard clue 
numbering scheme. Sequentially numbers each square left to right then top to bottom. By Letter is 
useful for coded-crosswords where each square is given a number depending on the letter in the square. 
None leaves the square numberless. 

If you select By Letter    the program will automatically create a code at random. To force the program to 
create a new code select Generate new code from the Grid menu. You can also select the Use 
sequential code item on the Grid menu if you prefer the code to be generated based on the order of 
appearance of the letters in the grid. 

You will generally wish to make this setting tally with a corresponding clue numbering scheme in the Clue 
Properties dialog box.

Square Sizes

The puzzle and solution sizes are given in millimeters. The grid is displayed on screen at the puzzle size, 
modified by the Zoom setting. Due to the low resolution of computer screens small changes in sizes may 
not show up on screen, but they will when you print the grid.

Size % of squares

Change these settings to modify the relative sizes of the lines, bars/border, numbers and letters in each 
square. The same setting is used for the thickness of bars and the puzzle border (if you select Thick 
puzzle border).

Advanced properties

Double Clicks

This setting determines what happens when you double click on a square or line in the grid. If Allow Bars
is not selected bars will never be inserted, regardless of how close to a line you click. If Allow Blocks is 
not selected you can insert bars by clicking only very approximately on the grid line. This is useful if you 
find it difficult aiming for a narrow grid line when you want to insert a bar using the mouse.



Default block type

This determines whether a clue square or a normal block is inserted when you double click or press 
Spacebar on a square.

Number sizes of grid

Select this option to number the top and left sides of the grid, outside of the grid.

Grid side numbering

This determines whether Roman numerals, letters, or numbers are used for the numbering. These 
settings are also used if you select clue numbering by position in the Clue Properties dialog box.



Square Properties

You can change the propertied of a square in the grid by moving the cursor onto the square and pressing 
Alt+Enter or clicking on the properties icon on the toolbar. You can change the properties of many 
squares at once by first selecting a number of squares in the grid.

The left hand side of the dialog box shows a preview of what the square looks like in the puzzle and in the
solution.

Colors

Change these settings to determine the background and letter color of the square. The options available 
depend on the type of square whose properties you are changing. The default colors for blocks and 
letters are set in the Grid Properties dialog box, change these if you want to change the settings for all the
squares. If you select the Custom item from the drop down color lists you will be presented with a color 
selection window to select any color of your choice.

Square Type

This shows the type of the square. Click on one of the buttons to change the square type.

Letter visible in puzzle

Check this option to make any letter in the square appear both in the puzzle and the solution. This is 
useful if you want to give some of the square in the puzzle as a starting hint.

Blank in puzzle

Select this option to hide all contents of the square in the puzzle. This is useful for creating skeleton 
crosswords where people have to fill in the blocks and numbers as well as solve the clues.

Formats in solution

This option determines whether the colors and bold/italic setting you have selected are used in the 
solution as well as the puzzle.

Don't number

Select this if you don't what the square to be numbered in the puzzle. This differs from Blank in puzzle in 
that it changes the following numbers as well as hiding the number for that square.

Bold and italic

Click these buttons to change the font used for the letter in the square. You need to have Formats in 
solution selected to see the effect in the solution.



Clue Properties

Select Clue Properties... from the Clue menu to change the way in which the clues are arranged and 
printed. There are three pages of settings, Format, which has general settings, Language specifics, 
which is useful if you want to create non-English crosswords, and Printout, where you can change how 
the clues are spaced on the page when you print them.

Select the Font... button at the bottom of the dialog to specify the font used for the clues.

Spacings

The Number-clue space is the distance between the clue number and the clue itself. The Between clues
space is the vertical separation between clues. A separation of zero will have the effect that the space 
between clue lines is the same as the space between clues.

Number format

Check the boxes here to specify how you want the clue numbers to appear.

Clue Headings

The Across and Down boxes contain the text which will head the across and down clues. You might want
to change these so that they are in capital letters, or to translate them to a different language. You can 
also specify some option for how the heading is formatted.

Clue Numbering

This setting determines the method used for numbering the clues. Normal is the standard numbering 
scheme. By first letter gives the clues sorted alphabetically by the starting letter of the clue word, with 
each clue 'numbered' by the starting letter. By position numbers the clues by row and column. If there is 
more than one clue on a row or column the clues are placed next to each other on the same line. 
Random order sorts the clues randomly, and gives each clue an alphabetical letter instead of a number.

Solution lengths after clues

Check this box if you want to automatically add the word format in brackets at the end of the clue.

Language Specifics

Alphabet

List here the alphabet of whichever language you want to use. The setting is used for various Crossword 
Compiler features, for instance for pangrammatic grid filling , clue numbering by first letter (above) and 
grid side numbering.

Linked clue text

This text appears when a word for a given clue is linked to another word. For example if 1 across is linked
to 10 across, the clue for 10 across would read 'See 1', or whatever text you use instead of 'See'.

Text for fill-in words

This is used for heading the words in the crossword when you print the words in the crossword by word 



length for fill-in puzzles. Use %u as a placeholder for the number of letters in the word, and put brackets 
around any letter that should only occur if there is more than one word of that word length. E.g. '%u letter 
word(s)'.

Single letter Across and Down

Select a letter that is used in clue linking to stand for across and down.

Printout

Change the clue spacings to effect how the clues are printed out. These spacings are used when printing 
any crosswords that you create. You can use them every time you start the program by clicking the Save 
these settings as default box. The spacings are given as a percentage of the total width, that is the 
width between the left and right margins.



Letter Indicators

Letter indicators are words used in cryptic crosswords to represent a certain letter, for example England 
represents the letter E. To see a list of indicators press Ctrl+L in the Clue Editor. You can customize the 
list if you like. See the Lookup Lists topic for more information.



Lookup Lists

When you press the book button on the Clue Editor toolbar a menu pops up with a list of available look-
ups which are available. By default there are Letter Indicators and Anagram Indicators. When you select 
an option another menu pops up with the available words. Selecting the word on the menu pastes it into 
the clue editor.

You can edit the letter and anagram indicators displayed by editing the ANAGINDS and LETIND files 
supplied with Crossword Compiler. Edit them using Notepad. The format of the file is

 MENU <Menu caption>
 First on submenu
 Second on submenu
 MENU <Second menu caption>
 First on second submenu
etc...

The menu captions can contain the '&' character, the letter following the character can be used as a Ctrl+ 
shortcut. 

You can add another lookup list by selecting the Custom Lookups page from the Preferences dialog 
box.



Anagram Indicators

Anagram indicators are used in cryptic crosswords to signal an anagram. To see a list of indicators, sorted
by first letter, press Ctrl+G in the Clue Editor. A menu will pop up and you can paste an indicator into the 
clue by selecting a menu item. You can customize the list if you like. See the Lookup Lists topic for more 
information.



WordWeb

WordWeb is an English thesaurus/dictionary add-on for Crossword Compiler. Once you have it installed 
you can use it from the Clue Editor to look up selected words, or from the Words menu. To look up a 
word (or a letter pattern) in the grid just press Ctrl+W. It can also be used to automatically format answer 
words correctly (if this option is selected under Preferences).

For more information on using WordWeb select Help from the WordWeb window's menu. 

Information about WordWeb is available on the Internet at http://www.x-word.com/wordweb/.



Preferences

You can customize various aspects of how Crossword Compiler behaves by selecting Preferences... 
from the Options menu. There are four pages of settings that you can change. The settings are global to 
all your crosswords, and you can save the settings as the default for each time you run Crossword 
Compiler by clicking the Save as default box at the bottom of the window.

Options

Opening and Saving

Select Create backup files to save the old file with a .BAK extension each time you save a file. Select 
the Show information on open option to show the Information dialog box whenever you open an 
existing crossword.

AutoFind on complete word

This setting determines what AutoFind will do when invoked on a complete word. Select See if word is in
list to just spell check the word—the word either will or wont be in the word list, and either will or wont be 
displayed. Select Find alternative words that would fit to find all the other words that could replace the 
word in the grid without affecting the letters that are part of intersecting words.

Display

Colors

You can change the color used for the grid cursor (when it's on a letter square), and for selected squares. 

Font for displaying words in lists

Click the Change font… button to change the font that is used in the AutoFind, Find Word, Word List 
Manager and various other windows whenever words from a word list are displayed. By default this is a 
fixed pitch font so that letters in words under each other are aligned. However you can choose any font 
you like. The fixed pitch fonts are usually Courier and FixedSys. A sample of the current font is shown to 
the left of the font button. If you wish to use different character sets in your word lists you should ensure 
that the font you choose supports the different character sets.

Clue Editing

Editing order

Using the Clue Editor you can either edit clues in the order of their clue numbers, or you can edit all the 
across words first, then the down words. 

Default database clue

This option determined which clue in the clue database is displayed in the clue editor when you edit a 
clue. You can view the rest of the clues in the database by clicking on the down button at the side of the 
Database entry.

Use WordWeb for automatic clue formatting

This option is available if you have WordWeb installed. If selected it will automatically use the WordWeb 
database to correctly punctuate words that are being clued.



Clue text when there is no clue

This text is printed when you print a clue before you've written it. 

Custom Lookups

You can add files and delete files that are used for lookup lists by clicking the Add and Delete buttons. 

Dictionaries

Select this page to add support for third party dictionaries to the Clue Editor. An extra button will appear 
on the clue editor's tool bar for each dictionary you add. Check the Save as Default box if you want to 
use these dictionaries every time you use Crossword Compiler.

This is an advanced setting and using it requires more than average computer know-how. The Crossword
Compiler installation program should have set up most of your dictionaries correctly. You should only 
need to change the settings yourself if you obtain a new dictionary after installing Crossword Compiler. 

To add a dictionary select the Add... button, and type the name of the dictionary (this should generally be 
the text that appears in the dictionary's window title when you run it). Type in the name of the application 
file in the Exe name input line, including the full path (e.g. C:\Chambers\Chambers'). If the program has 
command line parameters include these here too. To include the name of a look-up word in a command 
line parameter use the '%s' placeholder. E.g. for MS Encarta the Exe name might be 

c:\encarta\enc9632.exe /i "%s".

If the dictionary supports DDE (it should say so somewhere in its documentation) you can then enter text 
in to the Service, Topic and Command input lines. The Command entry can contain the '%s' placeholder 
to stand for the word being looked up. If the Command entry is blank the command will just be the word 
being looked up. If these lines are filled in correctly the clue editor button will bring up the dictionary entry 
for the word that is being clued, if not it will merely activate the dictionary program and you will have to 
type in the word yourself. These are the entries you need for some common programs (most of them will 
be set up for you automatically when you install Crossword Compiler):

Service Topic Command
Chambers CompLex WinWord None

Oxford Oxford WinWord None

Collins DIC Dictionary: COED
Thesaurus: CTAZ

LOOKUP %s

RH Webster's DIC Unabridged: RHUD
College: RHCD
Thesaurus: RHCT

LOOKUP %s

(Don’t actually include the “Dictionary” or “Unabridged” bit, just the bit in capitals).

The OED doesn't support DDE. Run the program to find out what the window title is, either 'Oxford 
English Dictionary    Second Edition' (note two spaces between Dictionary and Second). or 'Oxford 
English Dictionary (Second Edition)'. Set the name equal to whichever title your version has.

The programs that you add buttons for don't of course have to be dictionaries. You can create an icon for 



anything. Say you wanted to be able to start notepad easily. You could add a 'dictionary' called 'Notepad', 
file name 'c:\windows\notepad.exe' and leave the other entries blank.



Clue Squares

Clue squares are squares in the puzzle grid that contain short clues for surrounding words.

You can insert a clue square into the grid by double clicking, or double-clicking and pressing Alt 
(depending on the setting in Grid Properties) To edit the clues in the square, and to change the arrows 
which come out of the square, place the cursor on the clue square and press Ctrl+E or click on the Edit 
Clue button on the Toolbar. 

The Clue Square Editor

You can enter the clue or clues, up to five lines, in the central square of the dialog box. Press Enter to end
a line, and use a hyphen, alone on a line, for a horizontal line.

Click on the arrow buttons at the size of the square for the arrows that you want. When you press an 
arrow button the word in the direction of the arrow is displayed and any clues in the database for that 
word are also displayed. You can only have one arrow coming out of each side of the square.

To use a clue from the database press the Use clue button. To lookup a word that you haven't just clicked
the arrow for, double click on the word itself.

Click the check boxes at the bottom of the dialog box to raise or lower the left or right arrows. This is 
useful to align the arrows with the position of the corresponding clue in the square.

When you have finished editing the clues press Enter, and you will see your clues appear in the square in 
the grid. Be careful to make sure that you don't write more than one clue for a given word, and that each 
word in the grid has a clue square with the arrow pointing in the correct direction.



Linking word slots to make one snaking word

You may wish to have one long word or phrase in a grid that snakes around. You can do this by placing 
the cursor in the word slot that starts the snake, setting the typing direction to the direction of the word, 
and selecting Continue word down or Continue word across from the Edit menu. An arrow will be 
added at the end of the word to indicate the direction in which the word continues. You can undo the link 
by repeating the above sequence.



Advanced puzzles types and how to make them

This topic describes how to change the grid, square and clue properties to achieve various different 
effects in your puzzles. See the topics Standard Crosswords, Vocabulary/Freeform puzzles, Shape 
Puzzles, French Style Crosswords, Barred Crosswords and Clues in Squares puzzles for the standard 
puzzle types.

Skeleton puzzles and hint-
letters

To make the 'R' visible select the square and 
open Square Properties. Select the Letter 
visible in puzzle box. By selecting all the rest 
of the squares except the one numbered '5', 
selecting square properties, and clicking on 
Blank in puzzle you can make any evidence of
the other squares disappear.

 
Colored squares, letters and 
lines

Change the color of grid lines and block colors 
under Grid Properties. Use Square Properties 
to set the colors of individual squares. Set the 
color of letters and numbers by changing the 
grid font.

Clue Types

Un-numbered clues

A Some (3)

B Greek harp (4)

C Burden (4)

D Vase (3)

E Utilize (3)

F Aged (3)

Clues are displayed in random order, each is 
assigned a letter in order of listing.

Set Clue Properties Clue Numbering is to 
Random order.

Fill-in words

3 letter words 
ANY 

In these puzzles there are no clues and the 
idea is to try and fit the words into the grid. Just
create any type of puzzle and then print out or 
export Fill-in words.



OLD 

URN 

USE 

4 letter words 
LYRE 

ONUS 

The grids for this type of puzzle usually would 
have Square Numbering set to None under 
Grid Properties.

Desktop publishing

Once you have created a puzzle with Crossword Compiler you may wish to send it to a publisher, or to 
use it in one of your own publishing programs. 

If you have a Windows publisher program, or word processor, the easiest thing is to copy what you want 
to the clipboard and then paste it into the publisher program. You can export puzzles in more formats and 
with more options using the Export feature.

What you need to do when sending puzzles to a publisher will depend on who the publisher is, and what 
formats they can accept. Rich Text Format produced by the Export feature is generally good for clues, but
some publishers cannot use it for grids. For those that don't like Rich Text Format for grids your best bet is
probably Encapsulated Postscript (EPS). High resolution TIFF bitmaps may also be good, especially for 
grids containing pictures.

See the Export topic for details of the formats available for exporting puzzles.



Advanced DTP Features

For the advanced Desktop publisher Crossword Compiler supports DDE (Dynamic Data Exchange). This 
allows you to write macros or programs to quickly create publications based on Crossword Compiler files. 
For instance your macro or program could go through a list of files, for each one copying the puzzle and 
clues to the clipboard, arranging them in the publishing program, creating a new page, and then opening 
the next crossword and repeating.

The DDE topic to use is control; the application name is ccw4. Crossword Compiler can accept macro 
strings in the following format:

 [Command1(Params1)][Command2(Params2)][.....

The commands and parameters available are:

Command Parameters Example
Open "Filename" (must be in quotes) [Open("C:\CCW\My Crossword")]
Close None [Close()]
Quit None [Quit()]
Print None [Print()]
Export None

Number 0-8
[Export()]
[Export(2)]

Open opens the specified file.
Close closes the active crossword
Quit closes Crossword Compiler
Print shows the Print dialog box for the active crossword.
Export with no parameters shows the Export dialog box.
Export with a parameter copies the active crossword to the clipboard, according to the following 
parameter mappings:

 0 – Puzzle
 1 – Solution

2 – Numbered solution
3 – Code Grid (in coded puzzles)
4 – Code Solution (in coded puzzles)
5 – Clues
6 – Answers
7 – Explanations
8 – Fill-in words

Puzzle, solution and numbered solution, code grid and code solution are copied as a picture (metafile), 
the rest are copied as Rich Text Format. 



Tiling and cascading windows

You can have several crosswords open at once in Crossword Compiler, each one in a separate window. 
Select Tile side by side or Tile top to bottom from the Windows menu to size the windows and arrange
them so that you can see them all at once. Select Cascade from the Windows menu to show all the 
windows fairly large and overlapping so that you can see each one's title.



Creating Vocabulary Puzzles

To create a freeform puzzle from a list of words select New  from the File menu and click on the 
Freeform/Vocabulary button. The vocabulary puzzle builder inserts blocks (black squares) automatically 
in unused squares. If you want to fill in words around a given pattern of blocks use the Fill Grid feature 
instead.

Select Create vocabulary puzzle option on the Words menu to fit words into an existing grid. For 
example you may wish to design a particular shaped puzzle, or seed the grid with a few words before 
filling in the rest.

The buttons along the top of the Create vocabulary puzzle window give you different ways to specify the
words that you want to use:

Use Words 

Type in some words to use or select a Theme List and click on Build Puzzle. You can write the 
clues for the words that are used later on. This saves you writing clues for words that end up not 
being used. 

Use Words with Clues 

Type in words with clues, or select a clue database that you’ve made before, and click on Build 
Puzzle. This saves you having to do any extra work after you’ve built the puzzle. However you can’t
take advantage of any of the advanced features of the Clue Editor if you do this.

Use Word List

Select one of the main Word Lists to use and click on Build Puzzle. You can write the clues later.

An example: say you wanted to create a 6x6 puzzle containing names of common metals. In the create 
vocabulary puzzle window you would select the Use Words button and type in, say,

iron
gold
tin
lead
copper
silver
nickel
zinc

Click on the Build Puzzle button and the computer will automatically generate the puzzle:

To accept this puzzle press the Stop button. If you don't press Stop the computer will continue to search 
for puzzles that contain more of the given words. Press Stop whenever you are happy with the result 
produced. If you stop the fill but prefer one of the solutions found earlier you can Undo (Alt+Backspace) 



repeatedly to see the previous fills. You can cancel the fill at any time by pressing the Cancel button.

If you find that not enough of your words are used then try starting with a bigger puzzle (select New from 
the File menu).

Now for some more details on the various options:

Use Words

If you select the Use Words option you can save your list of words as a theme list by clicking on 
Save words. You can then use your words just like any of the other theme lists. To delete the words
you've typed in press the Clear button. You can also use words in any plain text file – click on the 
Load Clues button.

If you select a Theme List to use you can edit or add words to the list. Click the Save changes 
button if you want these changes to be automatically saved in the Theme List.

Use Words with Clues

Type in your words in the left column and the clue on the right. Click the Clear button to delete 
everything and start again, or click the Save button to save your words and clues in a clue database
for using again in the future. To use a clue database select one of the available databases in the 
Use Database drop down list.

Use Word List

The available main word lists are listed – just click on the one you want to use.    Set the Minimum 
word length to a number higher than two if you want to avoid short words. Set the Minimum word 
score to avoid words with scores less than the given value.

Options
There are various options available to customize how the process works. Select the Options button at the
top of the window to change them. The options you can change are as follows:

Surrounding squares

This setting determined what the computer puts in the squares in which there are no words. Select 
Blocks to create puzzles like those above, or select Voids to create a freeform outline puzzle. With Voids
selected the puzzle above would look like this:

Allow adjacent parallel words

This option determines whether junctions like 



are allowed or not. Here OPEN and NEAT count as adjacent parallel words, as do TEN and NEAR. With 
large word lists disallowing this kind of junction will make the fill significantly faster.

You can save the settings in the window by clicking the Save options button so that they will be 
automatically selected next time you start up the program.

Note that when you create a vocabulary puzzle the grid symmery is automatically changed to None.



HTML Templates

Crossword Compiler can export a web page containing the grid and clues from the current crossword. To 
do this it uses a template file that you can modify to change the look of the web page that is produced. 
For instance you may wish to change the background color and include a link to your home page.

HTML templates are stored in your Crossword Compiler Templates folder and must have the .HTML 
extension. You can edit the file with a text editor like Notepad, or you may be able to use a dedicated 
HTML editor if you have one.

To generate the web page for a crossword the program replaces various placeholders in the template with
the corresponding content for the current crossword. For instance, <CCCLUES> will be replaced by the 
clues (including Across/Down headers). See the Default template supplied for an example. 

The general placeholder syntax is <CCxxxx> where xxxx must be in upper case.    You can use the 
following placeholders:

 
<CCTITLE> Puzzle Title (see puzzle information)
 <CCCOPYRIGHT> Puzzle Copyright
 <CCAUTHOR> Puzzle Author
 <CCDESCRIPTION> Puzzle Description
 <CCCLUES> All the clues
 <CCACROSSCLUES> Just the Across clues (with the Across header)
 <CCDOWNCLUES> Just the Down clues (with the Down header)
 <CCJAVAAPP> Insert Java applet. 
 <CCENDJAVAAPP> Insert the </APPLET> tag. 
 <CCPUZZLE> The puzzle grid, of the form <IMG SRC=....>
 <CCSOLUTION> The puzzle solution, of the form <IMG SRC=...>
 <CCSOLUTIONURL> The file name of the solution grid (e.g. "MyPuzzle.GIF")
 <CCCODEGRID> Code grid for a coded puzzle
 <CCCODESOLUTION> Code solution for a coded puzzle
 <CCFILEROOT> The root name of the HTML file (e.g. "MyPuzzle")
 <CCDAY> The day
 <CCMONTH> The month
 <CCYEAR> The year
 <CCFONT> The clue font, of the form <FONT FACE=.... SIZE=...>
 <CCENDFONT> The end of the clue font, </FONT>

There is also the general placeholder

 <CCPROMPT This will be the prompt>

You can use any text instead of “This will be the prompt”. When exporting you will be shown a window 
asking for the “This will be the prompt” text. When you enter this it will replace the entire <CCPROMPT 
xxx> item with whatever text you enter. Use this to add additional custom items to the web page, maybe a
grid serial number, extra information, or whatever.

If you are exporting a Java puzzle you should use <CCJAVAAPP>. This should be followed by whatever 
text you want to appear if Java applets are not enabled when the web page is viewed. There must then 
be a <CCENDJAVAAPP> tag.

The are also a set of conditional elements. These must occur in pairs, the syntax being of the form



 <CCIFxxxx> stuff here </CCIFxxx>

The "stuff here" is only included in the web page if the xxxx is true. You can use the following conditional 
elements
 

 <CCIFTITLE> True if the puzzle has a title
 <CCIFAUTHOR> True if the puzzle has an author
 <CCIFCOPYRIGHT> True if the puzzle has a copyright
 <CCIFDESCRIPTION> True if the puzzle has a description
 <CCIFCLUES> True if clues were selected to be included
 <CCIFJAVA> True if the template is invoked from Java export
 <CCIFPUZZLE> True if the puzzle was selected to be included
 <CCIFSOLUTION> True if the solution was selected to be included
 <CCIFCODED> True if the grid numbering is by letter.
 <CCIFHASACROSSDOWN> True if clue numbering is Normal or By Position.
.<CCIFBUTTONS> True if using Java export with buttons in the applet

You can also use the corresponding <CCIFNOxxx> elements to be included if the negative is true.

The <CCFONT> and <CCENDFONT> elements will be deleted if the Include font info option is not 
selected.

You can create several different templates if you like. Just put them all in the Crossword Compiler 
Tempates folder and select the template you want to use when you export a web page.



The Professional Grid Filler

The features described here are only available if you have purchased the Professional Grid Filling 
module.

Manual word selection
Select this option under Fill Grid on the Words menu to give you complete control over which words are 
used in the grid filling processes. When you start the fill you will be prompted for which of the possible 
words to use in each word slot. See Grid filling with manual word selection for more information. 

Powerful grid filling
The Professional grid filler fills grids using a different method from the standard grid filler. This makes it 
significantly better at filling in hard grids. For example filling a 6x6 blank word square the Pro filler is up to 
ten times faster (depending on your fill settings). The Pro filler does more look-ahead which saves you 
time if you use manual word selection when you fill the grid. With less sophisticated filling methods you 
would be continually going back to replace words that were already in the grid because they caused a 
problem later on in the filling process. 

The Pro filler can only use 31 different letters. If your word list contains more than 31 different letters it will
only use words containing the 31 most common letters. This is no drawback for English and most west 
European languages, but for some languages this can be a problem (e.g. Icelandic). If you want to use 
more than 31 letters you can always use the non-Professional version (called “cc5basic”, in your 
Crossword Compiler folder).

Advanced filling options
Select the Advanced tab of the Fill Grid window to set various options for the filling process.

Exhaustive recursion

Select this option to make the filling process try out every possible combination of words until it finds a fit 
or gives up. In this case the filler will never give up if a fill exists (actually there is still a very small 
probability of a false fail, but it’s less than 0.01% for almost all cases). The trouble with exhaustive 
recursion is that the filler can spend a lot of time ruling out rather unlikely situations. Deselect this option 
to use a non-exhaustive filling method that will spend less time ruling out unlikely possibilities. The 
downside is that the fill may then fail even though there is a possible solution. 

Next word must be linked

Select this option to make the filler choose the next word slot to fill one with at least one intersecting word.
If this option is deselected the next word slot must only have at least one intersecting word on one of its 
intersecting word slots.

Start filling from cursor position

Select this option to make the filler start filling from the word slot at the current cursor position. If you 
deselect this option the filler will analyse the grid and start filling from wherever it thinks is best.

Max words to find in one go

This sets the absolute maximum number of possible words for each word slot that the filler will find. If you 



are using Manual word selection this will also be the maximum number of word choices that you are 
presented with. With Automatic word selection the higher the number the faster the fill. However higher 
numbers use up more memory, so use large number settings with caution. When you first ran the 
program the setting was set to a value likely to be OK with the amount of memory your computer has. 
Increase the setting if you install more memory or don’t mind Crossword Compiler using up a large 
proportion of your memory. Higher settings also result in better score optimization.

Possible words/buffer size ratio

The actual maximum number of words found for each word slot is determined by the Max words to find 
in one go (M) setting, the Possible words/buffer size ratio (P) setting and the number of words in the 
word list of that word length (N). If N divided by P is greater than M then the maximum number found will 
be M, otherwise it will be N divided by P. 

Select the Save advanced settings as default box to save your settings to be used every time you fill a 
grid every time you use Crossword Compiler. Otherwise your settings will be lost when you close 
Crossword Compiler.



Grid filling with manual word selection

Select Manual word selection when you fill a grid to manually choose each word to be used. (This is 
only available with the Professional Grid Filling module). Using this feature you have complete control 
over which words will be used by the grid filler. This is much better than inserting words by hand (using 
Find Word, say) since you can take advantage of the grid filler’s powerful look-ahead to reduce the 
number of times you have to replace words you’ve already put in the grid.

The Word Selection window

 

The Word Selection window has three pages. Click on the tabs at the top to change the page. You can 
use the buttons at the bottom to Cancel the fill, Stop the fill or make the fill Start Over from the first word 
slot. Click the Auto pick button if you want the filler to continue by choosing words automatically. You can
press the button again to revert to manual word selection. When the fill in complete you can use any of 
the buttons on the main toolbar exactly as when using Fill Grid with the automatic word selection.

The Word selection page

On the Word selection page you get a list of all the words that will fit in the current word slot. Whilst you 
are viewing the words the filler performs a background analysis of the words and removes ones which are
no good (i.e. would make it impossible to fill nearby word slots). At any time you can select a word and 
press the Use Word button to insert the word into the grid and move on to the next word slot. When the 
background check is complete the header of the word column says “all checked”

After the background analysis the Forced Words box at the bottom will list words that are formed as a 
result of using the currently selected word. Just change the selected word to view the forced words of 
each word. The score of the forced words is listed in brackets after each word.    In the example above 
you can see that if you used the word APPAL (score 50) you would also be forced to use the word 
YTTERBIC (score 25). Not all the words listed will necessarily have the same number of forced words - in



many cases there will be some choice in the nearby words.

If you don’t like any of the listed words and want to go back and replace the previous word press the 
Back button. If there is a word listed which you don’t like and want to remove from the word list then 
select the word and press the Delete word button (you will be prompted if you want to permanently delete
the word from the word list once the fill is complete). To lookup a word in a dictionary press the Lookup 
button (you can also select one of the forced words to look that up instead). This will pop-up a menu 
listing all the installed dictionaries; just click on one of them. Click the More button if you want to see more
words that will fit in the word slot.

Next to each possible word is listed a score and fill score in separate columns. 

The Score is just the score of the word plus the score of any words that will have no remaining 
intersections after this word slot is filled. For example, if one of the words is HAPPY and the Y would 
make the last letter in the intersecting word PLAY then the score would be the sum of the word scores of 
HAPPY and PLAY. The possible words are listed in order of the total score.

Before the background analysis the Fill Score is just some ad hoc measure of how easy the word would 
make the remaining fill. After the background analysis the Fill Score is based on a combination of two 
measures. Most of the score a sum of the maximum word scores available in the intersecting word slots if
the word were used. The remaining part of the score is a measure of how easy the word would make the 
remaining fill. So generally the higher the Fill Score the better. When the background analysis is complete
you can resort the words in score and then fill score order by clicking on the score column header (or 
select the option on the Options tab to resort automatically).

The Fill sequence page

Click on the Fill sequence tab to view a list of all the words that have been used so far. 

If you decide half way though a fill that you need to go back and change an earlier word you can select it 
in the Fill sequence list and press the Refill from button. This will undo all the words back to the selected 
word and offer you the alternatives available for that word.

The Options page

Click on the Options tab to customize aspects of the manual filling process.

Change the Selected background color to change the color of the highlight of the word slot in the grid 
that is currently being filled.

Check the Resort words on completion of background check box to automatically resort the possible 
words once the filler has determined a more accurate Fill score for all of them. The words will be resorted
firstly by score, then by Fill score, and then alphabetically.

Sometimes when you come to fill a word slot there is only one possible word that will fit. Change the 
Automatically insert single words option to control whether the filler will automatically insert single 
words without prompting.

Click the Save button to save your settings to be used every time you use Manual word selection. 

The font used for displaying the words can be changed under Preferences.



Viewing words used by Fill Grid

When you have completed a fill using AutoFill or Fill Grid  you can view the words used in the grid by 
selecting the Words used when you click the Menu button on the toolbar. If you want to view words at 
any other time select Words and word statistics from the Words menu.

The window lists the words used in fill order, along with the words’ scores. Press OK to close the window 
or press one of the other buttons at the bottom. Click on Refill from selected word to undo all the words 
in the grid until it the selected word and then refill with a different word in that word slot. Click Refill 
without selected word to do the same as Refill from selected word but to remove the words from the 
word list so it can’t be used again elsewhere.

Click the Check for similar words button to analyse the words used and highlight substrings they have 
in common. For instance if the grid contained REOCCUR and OCCUR the program would list the two 
words with the common substring highlighted. This can be useful if you want to avoid using similar words.

The font used for displaying the words can be changed under Preferences.



Exporting pictures
Metafiles – Bitmaps – EPS (encalsulated PostScript) – Comparison

You can export in a variety of picture formats by selecting Export from the File menu and choosing the 
Picture tab.

Pictures are exported at the size specified in the Grid Properties dialog box. There are three main types 
of picture you can export --- select one of the tabs in the export window.

Metafiles

These are Windows specific resizable pictures, and are good for exporting grids to other Windows 
programs like desktop publishers. 

However if metafiles are shown on a low resolution device like a screen the grid lines may appear uneven
or not show up at all (though they should print correctly). Select the For screen option to use thin grid 
lines which will appear correctly on screen. This is not such a good option if the metafile will ultimately be 
printed, but if the metafile will only be viewed on screen then this is the option to use. A metafile with the 
For screen option generally has a smaller file size than the corresponding bitmap and has the advantage 
of being resizable. However bitmaps are more portable and reliable, and should usually be used instead 
for viewing on screen.

Bitmaps

You can export bitmaps at various resolutions and color depths, and in various different file formats. With 
bitmaps the lines will always look correct if the bitmap is shown at its natural size, or if you export at 
sufficiently high resolution. 

The default Resolution setting is that of your screen, and will produce an image that looks much like the 
puzzle as you edit it in Crossword Compiler. Select a higher resolution setting if you want to export a 
bitmap for eventual printing. Either select a resolution from the drop down list or type in a value of your 
own. Note that exporting at high resolution can use a lot of system memory and lead to a large exported 
file.

Change the Colors setting to control the color depth of the exported image. The 16 million colors setting 
will always produce high quality results, and should be used if your grid contains any color pictures. 
However if your puzzle is essentially black and white or only has a few colors you can reduce the color 
depth to produce a significantly smaller image file. 

If you select the Anti-aliasing option the bitmap produced will use intermediate colors around the edges 
of letters to give the impression of a higher resolution image. If may also result in significantly better 
quality export if your grid contains pictures. You cannot use anti-aliasing with the monochrome color 
setting.

If you export to a file you can select three different file formats in the Save as type box:

Bitmap pictures are supported by most Windows programs and many others. The main 
disadvantage is that the bitmap file may be very large. 

GIF pictures are useful if you want to use the image on a web page. It is a compressed format 
supporting a maximum of 256 colors.

TIFF pictures are similar to bitmaps but they are compressed and are highly portable. This is 
probably the best option is you are exporting high-resolution images for publishing. At high resolutions



TIFF file sizes can be up to 50 times smaller than the corresponding bitmap files. TIFFs are exported 
with a minimum of 16 colors.

EPS (Encapsulated Postscript)

EPS is preferred by some publishers and is probably the best format for exporting for use on a Macintosh 
computer, especially with QuarkXpress. EPS file can be resized in other programs without loss of quality. 
You cannot export grids containing pictures to EPS.

Crossword Compiler automatically selects a PostScript font similar to the one you have selected as the 
grid font. You can however select from a range of fonts in the Font combo box, or type in the name of a 
different font (advanced users only).

If the Include TIFF preview box is checked the file will include an embedded color bitmap which you can 
then view on screen as a placeholder for the PostScript that will be used when the file is ultimately 
printed. The disadvantage of including a preview is that it will make the file size a little larger.

Comparison

Here is a table comparing the different picture formats, the color depths available, the typical files sizes, 
and their suitability for different purposes. The file size examples are for a black and white grid with 
antialiasing. File sizes for the compressed formats (GIF and TIFF) will increase significantly if there are 
more colors or the grid contains pictures.

Format Colors Typical file 
size (KB)

Screen Mac 
Publishing

Windows 
Publishing

Metafile 5 Option Maybe Yes

Bitmap 2
16
256
16 million

20
75
150
450

Yes OK Yes

GIF <=256 6 Yes 
(Web)

No No

TIFF 75 DPI
TIFF 300 DPI

>=16 7
53

Yes
(not Web)

Yes Yes

EPS 
With Preview

4
12

No Yes Yes

To see the effect of anti-aliasing compare these:

With Anti-aliasing Without anti-aliasing

                

The ones with anti-aliasing look as though they have thicker lines and letters. That is because it looks 



more exactly in proportion to the settings set under grid properties than the other image. With no anti-
aliasing the lines are restricted to being an exact number of pixels wide. You can also see that anti-
aliasing has made the small numbers clearer, especially the 4. However there is little point in using anti-
aliasing if you are exporting at the highest resolution your printer can support. It is mostly useful for low-
resolution images that will be viewed on screen.



Creating Java Crosswords

Select the Java tab in the Export window (on the File menu) to export puzzles to be solved interactively 
on a web page. You can also use the Web page export option on the File menu to quickly generate a web
page using the default options.

Crossword Compiler comes with a little program, called a Java applet, that you can use on your web 
pages so that people can solve puzzles interactively. They can type letters into the grid and click on 
squares to highlight the corresponding clue. The Java export feature produces a web page that will use 
the Java applet.

The Java export feature produces a web page file and a puzzle file. These must be uploaded to the same 
folder on your web site. In addition you also need to upload the applet files. You only need to do this once 
since all your puzzles can use the same applet files on your web site. You can find the files in the 
Crossword Compiler/Puzzles/Java folder. The ccjava.zip and all the .class file should be copied to the 
same folder on your web site. This can either be the same folder as you copy the web page to, or the 
folder specified in the applet’s Codebase setting (see Java Applet Properties).

There are various options on the Java export tab. To start with you can probably leave them all 
unchanged.

Interactive clues

Select this option to automatically show the corresponding clue when the solver clicks on a square in the 
grid, or to highlight the correct slot in the grid when the solver clicks on a clue in the clue list. Select Text 
Clues if you just want to have static clues – they will be in HTML according to the settings on the web 
page export tab.

Buttons

The applet can display various buttons giving the solver some extra options. Select which buttons you 
want to be available. The Reveal button is a cheat button to show the answer to the current clue. The 
Check button will delete any letters the solver has put in the grid that are incorrect. The Submit button 
will submit the solver’s solution, and the Save button will save the solver’s current progress. The Revert 
button makes the puzzle revert to the state when it was last saved (usually completely blank).    The 
Solution button shows the solution.

The Save and Submit buttons require advanced additional work by the web site manager: you must 
supply a CGI script to handle the save or submission data. Set the CGI script URL under the Applet 
Options.

If you do not show any of the Reveal, Check, or Solution buttons the Java puzzle file will not contain 
solution information, and will therefore be secure for a prize crossword.

Numbers visible in grid

If this is selected the grid will be numbered as usual. If you have a large grid with a small square size the 
numbers may be hard to read or look messy, in which case you can deselect this option to hide the 
numbers. With interactive clues the numbers are redundant anyway since the user can find out 
immediately which clue belongs to which word slot.

Square size

Change the size of each grid square in pixels. This also indirectly affects the width and height of the grid, 



so ensure that the square size isn’t so big that the whole grid won’t be visible on the web page.

Clue font size

Change the size of the font used to display the interactive clues.

Solution link

Include a link to GIF picture of the solution.

Numbered solution link

Include a link to a GIF picture of the numbered solution.

HTML Template

Change this setting to use different templates for the web page that is produced. See the HTML 
Templates topic for how to create your own templates.

Applet options

Click this button to customize various aspects of the Java applet. See the Java Applet Properties topic for 
more information.



Java Applet Properties

Click the Applet options button on the Java tab of the Export window to customize the way the Java 
applet works.

Clue Layout

You can have the clues either to the left, right or below the grid.

Clue Font

Choose SanSerif or Times Roman. Exactly how the font will look will depend on which system the puzzle 
is being solved on.

Clue View

Set the Width (or height if the clue layout is set to Below grid) of the clue display. You should ensure that 
the longest clue easily fits in the clue view window, and that the clue view width isn’t so large that it won’t 
all be visible in the web page. Set the grid-clue gutter to determine the space between the grid and the 
clues, and between the clue views. Measurements are in pixels.

Show bar separators in collocations

Select this option to put a thick line between squares where there is a space in the solution. For exmaple 
if a word was “top hat”, this option would put a thick line between the “p” and the “h”. You must have the 
word formats set correctly for this to work, and the setting is ignored if the puzzle you are exporting 
contains bars.

Codebase

This gives the location of the Java applet .zip and .class files. If these are not in the same folder as 
the .html file you need to change the codebase setting, otherwise it can be left blank. Note that the applet 
files must be on the same server as the web page.

Save URL (Advanced users only)

The URL of the cgi script to run when the Save button is clicked in the Java applet. The cgi script will be 
passed a string representing the letters in the grid, with hyphens for blank letters. This string can then be 
used as the PROGRESS parameter for the applet to restore the solver’s progress. It is up to the CGI 
script to manage how the saving process actually works. The URL should include the ? character.

Example: For a script called “saveme.cgi” at “http://www.x-word.com/cgi-bin” folder the Save URL would 
be “http://www.x-word.com/cgi-bin/saveme.cgi?”.

The Save URL is stored in the HTML file in the Applet’s “SAVE” parameter. It can thus be generated 
dynamically if required. Note that the Save URL must be on the same server as the .html file otherwise 
you may get a Java security violation.

Submit URL (Advanced users only)

The URL of the script to invoke when the solver presses the submit button. As for the save button the 
page is passed a string representation of the letters in the grid. The Submit URL is stored in the HTML file
in the Applet’s “SUBMIT” parameter.



Colors

You can change the colors used in the applet. Be careful using custom colors since these may not be 
available on the solver’s system. 

Completion Message

This message appears when the solver has filled in the last blank square of the grid. It can contain 
several lines.

Button Captions

You can change the captions of the various buttons that the Java applet can show. This is useful if you 
want to change the captions to another language. You may also wish to change the English captions. For 
example, if you don’t implement the Save button, the Revert button may be better given the caption 
“Clear”.



Lock Grid

Select the Lock Grid  menu item on the Grid  menu to prevent accidental changes to the grid once you 
have finished it. To enable editing again just deselect the Lock Grid menu item.



Web page export

Select Web page export from the File menu to export your puzzle to a web page. This command will 
export a page using default settings. For complete control over the export process use the options under 
Export instead.

Crossword Compiler can export two kinds of web page. The first kind will have an interactively solvable 
grid where the solver can type answers into the grid on the web page. Clicking on a square in the grid will 
highlight the corresponding clue in the list of clues to the side. The second kind of export simply shows a 
picture of the grid with the clues listed beneath. Most web browsers can show interactive puzzles, but 
some browsers cannot, usually if they have Java disabled. (The interactive puzzle works by running a 
little program called a Java applet. Users can opt to disable these applets in their web browser). Choose 
which kind of export you want to use.

You will then be prompted for a file name to export the puzzle to. If you are exporting an interactive puzzle
you should probably export to the suggested folder which contains the necessary files for the applet to 
work.

When the export is complete you will be shown a list of the files produced, and given the opportunity to 
view the page in your browser.

For more details on Java and web page export see the Export topic.



Adding to a grid library

Select Add to grid library from the Grid library submenu of the Grid menu to add the current grid 
pattern to a grid library.

Just select the grid library you want to add the pattern to, type in a name for the pattern if you don’t want 
to use the defaul name, and press Add.    If you want to add the pattern to a new library click the New 
button, type in a name for the new library, and then add as before. 

You can then use your grid pattern when you make a new crossword or by selecting Use grid library 
from the Grid menu. You can also delete a grid library or rename a grid pattern by using the Use grid 
library window.



Using a pattern in a grid library

Select Use grid library from the Grid Library submenu of the Grid menu to use a pattern from a grid 
library with the current crossword. This way you can use previously designed grids rather than editing the 
pattern of squares by hand.

Click on the grid library you want to use at the top of the window and then select one of the available 
patterns. If no patterns are listed then there are no available patterns for your current grid size. When you 
select a pattern it will display in the crossword. Click OK when you have selected the one you want to 
use.

If you cannot see all the grid behind the use pattern window you can click on the Minimize button at the 
top right of the window to minimize the window so that you can see all of the grid.

You can delete or rename a pattern from the library by selecting an item from the right-click popup menu. 
You can also delete an entire grid library by selecting it and pressing Delete (but you cannot delete any of 
the supplied standard grid libraries).



Extracting grid patterns from files

Select Add patterns from files from the Grid Library submenu of the Grid menu to add all the grids 
from a batch of files to a grid library. 

Select the files you want to extract grid patterns from. Then selec the library to add the patterns to and 
enter a Grid pattern name. You can use the placeholders %W for the number of word slots, %B for the 
number of blocks, %C for the number of letter squares in the grid, %N for the number of the grid added 
(i.e. 1,2,3... up to the number of grids you add), %L for a word count of the three longest word slots, %Ln 
for a words count of the n longest word slots and %Xn for the count of words of length n. Click on Add 
and you will be asked whether you want to suppress duplicate grids. The program will then open each file 
in turn and add each grid to the grid library that you selected. 



Deleting bars

Select Delete all bars from the Grid menu to delete all the bars in a puzzle.

Bars are thick black lines between squares that can be used to delimit words instead of blocks (black 
squares).



Merging grid libraries

Select Merge grid libraries from the Grid Library submenu of the Grid menu to add the grid patterns in 
one grid library to another grid library.

Select a target library to merge other libraries into from the list of libraries at the top of the window. Then 
from the bottom list of available libraries select the libraries you want to add. Click on Add to add the 
libraries selected at the bottom to the library selected at the top.

To select more than one library to add hold down the Ctrl key and click with the mouse.



Importing clues

Select Import clues from the Clue menu to insert clues from a plain text file. You should have the grid 
completed before using this feature. If you want to import a plain text file including grid data use Open on 
the File menu.

The import expects the file to contain across clues followed by down clues. There may be a clue heading, 
and clue numbering is ignored if it is present. 

When the import is complete the Review Clues window is opened so you can check that everything 
imported correctly.



Delete all clues

Select Delete all clues from the Clue menu to delete all the clues in the current crossword. This can be 
useful if you want to create two crosswords with the same grid but a different set of clues.



Theme Lists

Theme lists are fairly small collections of themed words that can be used for creating vocabulary puzzles 
or as a theme when you fill the grid. Theme lists are stored in a plain text format, and should not usually 
contain more than a few thousand words at most. Crossword Compiler is supplied with a variety of theme 
lists that you can use. You can also create your own using the vocabulary puzzle feature, or by converting
a main Word List.

The main Word Lists are larger collections of words, can be of any size, and also have a score associated
with each word.

Theme Lists are stored in your Crossword Compiler Word Lists/Themes folder.



Hint messages

Crossword Compiler will produce hint messages for some features to help you the first few times you use 
them. You can skip the hint message in future by clicking the Don’t show me this again button. There 
are also a couple of similar options for skipping steps under New Crossword.

You can re-enable all the hints that you’ve skipped by selecting Re-enable all hint messages from the 
Options menu.



Starting a new crossword

You can start a new crossword by selecting New from the File menu or clicking on the icon on the toolbar.
The New Crossword window will also appear when you start the program.

Click on the button corresponding to the type of puzzle you want to make. You can also click on one of 
templates and press the Other template button to create other types of puzzles.

The options are:

Cryptic or quick Standard non-American puzzle.

American Standard American puzzle

Freeform/vocabulary Non-symmetric puzzle using themed words. You can generate 
these automatically from a short list of words.

Shape Puzzle with a non-rectangular outline. You can fill the shape with 
words from a short list.

Other templates supplied are

Barred Words are separated by thick lines rather than black 
squares.

Clues in squares Short clues are written directly into squares in the grid.

Coded Each square has a number corresponding to the letter, crack
the letter code to solve the puzzle.

French Style Squares are numbered down the side and clues numbered 
by column and row.

If you want to re-open an existing puzzle click the Recent files button and select one, or click on the 
Open existing file button. If you don’t want the New Crossword window to show when you start the 
program uncheck the Show at startup box.



Coded crosswords

Select the Coded template in the New Crossword window to make 
one of these. Each letter in the grid is assigned a different number. 
The idea is to fill in the grid just from the pattern of numbers. There 
are no clues.

Make a hint letter visible in the puzzle by selecting a square and 
changing the item under square properties.

Code grids show the code solution and are generated automatically by Crossword Compiler and look like 
this:

See also:

Using a grid libarary grid pattern
Editing the grid
Automatic grid filling

Grid Properties
Square properties.



French style crosswords

Across 
1 Aged

2 Some

3 Vase

4 Utilize

Down 
II Burden

III Greek harp

Select the French Style template in the New Crossword 
window to make one of these. 

Individual squares are not numbered. Clues are numbered by 
their position in the grid. If there is more than one clue on a 
given row or column then the clues are juxtaposed under the 
same number.

See also:

Using a grid libarary grid pattern
Editing the grid
Automatic grid filling
Finding words to fit
Writing Clues

Grid Properties
Clue Properties



Standard crosswords

Across 
1 Aged (3)

3 Some (3)

4 Vase (3)

5 Utilize (3) 

Down 
1 Burden (4)

2 Greek harp (4)

Click on the Cryptic or quick or American button in the 
New Crossword window to make one of these. 

After you have chosen a size for the grid select a grid 
pattern to use. Alternatively click on Design grid myself to 
make a new grid pattern. 

If you design the grid yourself you can insert blocks (black 
squares) by double clicking or pressing the spacebar. Once
you've put the blocks where you want them you can fill the 
grid using AutoFill., fill the grid semi-automatically using 
AutoFind or type words in yourself.

Cryptic or quick puzzles usually have the word length in 
brackets after the clue, American puzzles do not. Change 
the setting under Clue Properties.

See also:

Using a grid libarary grid pattern
Editing the grid
Automatic grid filling
Finding words to fit
Writing Clues

Grid Properties
Clue Properties
Advanced puzzle types



Barred crosswords

Select the Barred template in the New Crossword 
window to make one of these. After you have chosen a 
size for the grid select a grid pattern in the grid library or 
click Design grid myself to make a new grid pattern. 

Bars instead of blocks separate words. If you design the 
grid yourself insert bars by pressing Alt+Cursor keys, or 
double clicking on a line with the mouse.

Barred puzzles usually have a thick border, set under Grid
Properties..

See also:

Using a grid libarary pattern
Editing the grid
Automatic grid filling
Finding words to fit
Writing Clues

Grid Properties
Clue Properties



Shape puzzles

Click on the Shape button in the New 
Crossword window to make one of these.

You can either select one of the shapes in
the supplied grid libarary, like the one on 
the left, or click Design new shape to 
make your own.

Use the Create vocabulary puzzle 
feature to fill in the shape automatically 
with words from a short list. Alternatively 
you can edit the grid yourself.

To design a shape yourself remove the grid lines from squares by pressing Ctrl+Delete or using Remove 
Blanks. Shape puzzles usually have a thick border, but you can change this under Grid Properties. You 
may like to change the colors of the grid lines or individual squares. To do this change the settings under   
Grid Properties or Square properties. If the puzzle shape you are making is symmetric you can change 
the grid symmery setting appropriately.

See also:

Editing the grid
Creating a vocabulary puzzle 
Writing Clues

Grid Properties
Square properties.
Clue Properties



Freeform/vocabulary puzzles

Click on the Freeform/vocabulary button in the New 
Crossword window to make one of these. Once you have 
chosen a size for the grid you can use the Create vocabulary
puzzle feature to automatically generate the puzzle from a 
list of words.

Freeform puzzles can be in either of the forms shown on the 
left. Change the option in the Create vocabulary puzzle  
window to make an outline puzzle rather than filling around 
words with black squares.

See also:

Creating a vocabulary puzzle 
Writing Clues

Grid Properties
Clue Properties



Clues in squares puzzles

Select the Clues in squares template in the New 
Crossword window to make one of these.    Clues are not
written separately, but short clues are written into 'clue 
squares', which have arrows pointing to the clued word.

Double-click to insert a clue square, and press the edit 
button to bring up the clue square editor.

See also:

Editing the grid
The clue square editor.

Grid Properties



Using a grid pattern

Once you have selected the type of puzzle you want to make in the New Crossword window and you 
have chosen a size for the puzzle, you can then select a grid pattern from a grid library. Which grid library 
you use will depend on what type of puzzle you want to make.

To use one of the grid patterns just click on the pattern name and you will be able to view the pattern. You 
can select a different Grid library if you want to. Click the Use pre-designed grid to use the pattern you 
have selected. If you selected the cryptic or quick style you will also be given the option to fill in a basic 
pattern of alternating blocks.

If you use one of the patterns from the grid library you will then be asked how you want to enter words 
into the grid. You can select to enter them by hand, automatically using AutoFill, or with custom settings 
using Fill Grid.



Copying and filtering Word Lists

To make a copy of a word list select a word list and click on Duplicate/filter list on the Word List 
Manager’s Word List menu. Then type in a name for the copy of the word list.

If you want the copy to contain only words of a particular score, click the Include only words with 
scores of: check box and select the scores you want to include.

The Duplicate/filter list window is also a handy way of viewing the number of words with each word score.

Copying lists is often useful. For instance you might want to generate a list of all the words that are in list 
A but not in list B. To do that you’d first create a copy of A, called C say, and then remove the words in list 
B from C. The list C would then contain the words in A but not in B.



What's new in version 5?

Designing/using grids

New Crossword window completely re-designed
Grid Libraries (see using a grid library).
Grid libraries supplied for cryptic/quick, American, Barred and Shape puzzles
Any shape can now have a thick border (under Grid Properties)
Lock Grid feature to prevent accidental changes to completed grids.
Paste a word at cursor position (Ctrl+Shift+V)
Delete all bars on the Grid menu.

Grid Filling

Much improved grid filling algorithm
New menu of options on completion of fill
Generate several fills and easily view the differences
View the words used by the fill
Re-start a fill from the beginning mid-process
Use a theme from a plain text Theme List.

The professional grid filler (optional)

The world’s most powerful grid filling engine
Grid filling with manual word selection.
New advanced filling options

Creating vocabulary puzzles

New Theme Lists supplied for filling (you can also make your own).
Create puzzles directly from a list of words and clues
Create in non-rectangular shapes
Fill around words and patterns already in the grid

Clue editing

Review/Edit clues button on Toolbar.
New lookup lists
Select part of the word or clue to be looked up in a dictionary
Use up/down cursors to move between clues in the Review/edit clues window
Import clues from a plain text file.
Delete all clues

Web publishing

Web page export
Java Applet for interactive puzzles
Export web pages from templates 
Export HTML for use with web authoring programs

Exporting puzzles

Encapsulated Postscript with TIFF preview
High-resolution bitmaps (BMP and TIFF)



Metafiles for display on screen
Anti-aliasing for better low-resolution export
Plain text with answers
Copy to clipboard now copies multiple formats
Better color management and color export options
Automatic conversion of formatted clues to plain formats

The Word List Manager

Duplicate/filter lists
Improved for multi-language use
Import and export plain text lists with scores
Various speed improvements

Miscellaneous

Define and use custom colors
Improved AutoFind with intersection checking
Open plain text puzzles
Hint messages (removed for ever at a single click) for the first-time user
Various minor changes and bug fixes
Clue Properties option to include format only if word is a compound
Change the font for showing word lists under Preferences

New since version 4.0

Create freeform vocabulary puzzles from a list of words
More powerful word finding
Spell-check clues in Review/edit window
Export GIF pictures
Word statistics and check for similar words
Option to print solution on a separate page
Export and open Across, Crossdown and Crossword Maestro puzzles
Paste plain text (Shift+Ctrl+V) in the clue editor
Sequential codes (as well as random) for coded puzzles
Multiple headers
Autofind with intersection checking
Clue printout options under Clue Properties




